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Understanding the CMM

We use a coordinate system to describe the movements of a measuring ma-
chine.  The coordinate system, invented by the famous French philosopher and
mathematician René Descartes in the early 1600's, lets us locate features relative
to other features on a part.

A coordinate system is a lot like an elevation map where the combination of a
letter along one edge of the map, a number along the other, and elevations
shown throughout uniquely describes each location on the map. This letter/
number/elevation combination is called a coordinate and represents a specific
place relative to all others.

Another example is a street map with buildings shown (Figure 1). To walk to
your hotel room at the Ritz Hotel from the train station (your origin), you walk
2 blocks along Elm street, 4 blocks on Maple and up 3 floors in the Ritz. This
location can also be described by the coordinates 4-E-3 on the map, corre-
sponding to the X, Y and Z axes on the machine. These coordinates uniquely
describe your room and no other location on the map.
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A coordinate measuring machine (CMM) works in much the same way as
your finger when it traces map coordinates; its 3 axes form the machine's
coordinate system. Instead of a finger, the CMM uses a  probe to measure
points on a part (Figure 2). Each point on the workpiece is unique to the
machine's coordinate system. The CMM combines the measured points to
form a feature that can now be related to all other features.

Understanding the CMM
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The Machine Coordinate System

There are two types of coordinate systems in the world of measurement.  The
first is called the Machine Coordinate System.  Here, the X, Y, and Z axes
(Figure 3) refer to the machine’s motions.  When viewed from the front of the
machine, the X axis runs from left to right, the Y axis runs from front to back,
and the Z axis runs up and down, vertically perpendicular to the other two.

X Axis

Y Axis

Z Axis

Figure 3
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The Part Coordinate System

The second coordinate system is called the Part Coordinate System where
the 3 axes relate to the datums or features of the part.

Before the introduction of computer software to coordinate measurement,
parts were physically aligned parallel to the machine’s axes so that the
Machine and Part Coordinate Systems were parallel to one another. This
was very time consuming and not very accurate. When the part was round
or contoured, rather than square or rectangular, the measurement task was
nearly impossible.

Figure 4
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Alignments

With today's CMM software, the CMM measures the workpiece's datums
(from the part print), establishes the Part Coordinate System, and mathemati-
cally relates it to the Machine Coordinate System.

The process of relating the two coordinate systems is called alignment (Figure
4). With a street map, we do this automatically by turning the map so that it is
parallel to street (datum) or to a compass direction (i.e., north). When we do
this, we're actually locating ourselves to the "world's coordinate system".

Figure 5
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Datums

A datum is simply a location. We use datums as guides to tell others where
we are or as directions on how to get to places. On the map, the Ritz Hotel
is a datum. So are streets, the train station, the museum and the restaurant.
Thus, by using an origin, datums, directions and distances people have all
the information they need to get from one location to another.

For example, to get from the train station (origin) to the restaurant, you
walk 2 blocks north on Elm Street (datum), take a right, and walk 2 blocks
east on Maple (datum).

In metrology, a datum is a feature on a part such as a hole, surface or slot.
We measure a part to determine the distance from one feature to another
(Figure 7).
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Translations

Suppose you need to know how far a specific feature of a part is from another
feature (Figure 8). Take, for example, the distance to the centers of each of four
holes from a central hole. To do this you would first measure the central hole,
translate the origin to the center of this hole, and then measure each of the
four surrounding holes.  Moving the starting point (origin) of the measurement
from its present position to another place on the part is called translation. The
CMM does this mathematically when you request an alignment routine from
it's geometric measuring software.

In terms of our street map, once you arrive at your hotel and decide to eat at a
legendary restaurant on your visit to the city, you need to find it on the map.
The hotel now becomes your new starting point, or origin.  By knowing your
location, you can tell by looking at the map that you will have to travel two
blocks west along Maple Street to reach the restaurant (Figure 6).

Translated Origin

Figure 8

Original Origin
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Rotations

Not all datums are at right angles to other datums.  For example, looking at
your street map (Figure 9), you see that the Museum is located on a street
that's neither parallel nor at right angles to the streets the Hotel, Restaurant
and Train Station are on. Thus to determine how far it is from the Hotel to
the Museum, you have to first translate your origin to the Hotel and then
rotate the key to be parallel to the street on which the Museum is located.
Now you can easily measure the distance from the Museum to the Hotel.

The exact same procedure applies to the part (Figure 10). The distance
between the two holes on the part can be measured once the original origin
is translated to the smaller hole and the part coordinate system is math-
ematically rotated 45°. Now both holes lie along the new Y axis and the
distance can be calculated automatically.
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Measured and Constructed Features

What’s the difference between measured and constructed features?

The vast majority of parts are made up of simple geometric elements created by
machining or forming. These primary elements (points, lines, circles, planes,
cylinders, cones, spheres) are called features.

When a CMM can measure these features directly, by probing the feature's
surfaces, the features are referred to as measured features.

Other features, such as distances, symmetries, intersections, angles and
projections, cannot be measured directly but must be constructed mathemati-
cally from measured features before their values can be determined.  These are
called constructed features.

In Figure 11 the "constructed circle" is constructed from the center points of
the 4 measured circles.

Measured Circles Constructed Circle
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Constructed Features

The relationships between features are critical to many manufacturing
processes.  For example, the constructed intersection point from two
measured cylinders of an engine block can be used to determine how well
other parts will fit together.

Measured Features
Measured Features

Constructed Intersect Point

Figure 12
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Volumetric Compensation

Although advanced manufacturing technology makes it possible to tolerance
and make parts very precisely, imperfections still exist. Small as they may be,
the fact that there are tolerances means that there are errors.

Coordinate measuring machines are no different from other products in this
respect. While they are built to extremely tight tolerances, there are errors
(roll, pitch, yaw, straightness, squareness and scale errors) in their structure
that effect their accuracy. As manufacturing tolerances become increasingly
tighter, it is necessary for CMMs to become more accurate.

The majority of the CMM's inaccuracies can be corrected automatically in the
CMM’s controller.   Once all of the geometric errors of the CMM are mea-
sured (called error mapping), they can be minimized or even eliminated by
powerful algorithms in the CMM's software. This technique is called volumet-
ric error compensation.

By eliminating errors mathematically, you lower the cost of manufacturing
and provide the customer more performance for their money.

For more information on how the RefleX system handles its volcomp files, see
Section 11 of this manual.
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Volumetric Compensation

Volumetric compensation or "volcomp" can be best understood in terms of
the relationship between a map and a compass.  If you want to sail to a
particular location, you have to know its true direction from your current
position (origin). A compass and a map are used determine your direction,
or bearing.  There is, however, a difference between true north and magnetic
north.  This difference is called variation and is caused by the offset
between the true north pole and the magnetic north pole. Thus, to determine
the true direction from one point to another, the variation between true
north and magnetic north must be added or subtracted from the compass
bearing.

In the map shown (Figure 13), the difference between true north and
magnetic north (15½ at Brown & Sharpe Headquarters in RI, as of 1998),
must be compensated for or a sailor would end up northwest of the intended
goal and would run aground before reaching the final destination.

A coordinate measuring machine does a similar compensation automati-
cally to remove the variations of the machine from the measurement.

True North

Magnetic North

315°

Figure 13

15°
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A projection is the reproduction of a part feature on another feature, such as
projecting a circle or line onto a plane, or a point onto a line.

Projecting one part feature onto another can be compared with the creation of
the traditional "flat" map of the world (Mercator projection). The flat map is
made by projecting a globe of the world (sphere) (Figure 14), onto a plane
(Figure 15).

Projections

Figure 14

Figure 15
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Projections

In metrology, projections allow the operator to measure more accurately
and to see how mating parts will eventually fit together.

The automotive industry often makes cylindrical measurements such as
those found in engine blocks. By projecting a cylinder into the plane of the
head, you can determine how the piston will fit into the cylinder and how
that piston will fit the combustion chamber in the head.

A minimum number of three points is necessary to measure the diameter of
a circle. But, if those points are not at the same distance from the top of the
bore, the measured diameter will be shown as elliptical (Figure 16).  To
overcome this misrepresentation, the measurement data is projected onto a
plane that is perpendicular to the centerline of the cylinder. The result is an
accurate determination of the circle's properties.
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Tip Compensation

CMMs gather their data by touching the part with a probe (either a solid probe
or an electronic touch trigger probe). Because it's the tip's circumference that
touches the part, the probe's center and radius must be known prior to measur-
ing. This is done by measuring a very accurate sphere, called a qualification
sphere.

Once this tip information (center location and radius) is known, the system will
go back and add or subtract 1 tip radius from the points after a feature has been
measured.

Probe Offset

Center of Prob
Center of Meas

Probe Tip

Figure 17

Stylus

Tip Center

Tip Radius
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Effective Probing Techniques

By using effective probing techniques when inspecting a part, you can
eliminate many common causes of measurement error.

For example, probe measurements should be taken perpendicular to the
workpiece surface whenever possible (Figure 18). Touch trigger probes
used on coordinate measuring machines are designed to give optimal
results when the probe tip touches the workpiece perpendicularly.  Ideally,
you should take hits within ±30° of perpendicular to avoid skidding the
probe tip.  Skidding produces inconsistent, non-repeatable results.

Probe hits taken parallel to the probe body, that is, along the axis of the
stylus, are not as repeatable as those taken perpendicular to the axis
(Figure 19).

PART SURFACE

PROBE PATH

APPROACH OF THE PROBE

SHOULD BE WITHIN ±80

OF THE PERPENDICULAR

TO MINIMIZE SKIDDING ERROR

POINT TO BE PROBED

Note that probe approach
vectors are perpendicular
to the surface of the sphere

Figure 18

Point to be probed

Figure 19

Parallel to the Probe Body
(Along axis of stylus)

Highest Repeatability
Perpendicular to the
Probe Body

Note that probe
approach vectors are
perpendicular to the
surface of the sphere.

Approach of the probe
should be within ±30°
of the perpendicular to
minimize skidding
error

Probe path
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Probe hits that are neither perpendicular nor parallel to the probe body (Figure
20) produce results that are even less repeatable than those taken parallel to the
probe body. You should avoid taking probe hits parallel to the stylus and at an
angle to the probe body, since they will produce large errors.

Shanking is another cause of measurement error (Figure 21). When the probe
contacts the part with the shank of the stylus and not the tip, the measuring
system assumes the hit was taken in a normal manner and large errors will
occur.

Effective Probing Techniques

Neither Perpen-
dicular nor Parallel
to the Probe Body

Very Low repeatability
(Should be avoided)

Neither Perpendicular
nor Parallel to the Probe
Body but along the axis
of the stylus

Probe

Stylus Knuckle

Figure 20

Figure 21

Shanking

Correct Probe Contact

Shanking
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Effective Probing Techniques

You can reduce the likelihood of shanking by using a larger diameter tip.
This will increase the clearance between the stem and the part's surface
(Figure 22). In addition, the larger the tip, the less the measurement is
effected by the part's surface finish because the contact point is spread over
a larger area. However, the largest tip that can be used is limited by the size
of the smallest holes to be measured.

Measurement points taken with a touch trigger probe are recorded when the
stylus is deflected enough to break its internal electrical contacts. The
longer the probe tip extension, the larger the pre-travel error. In addition,
longer probes are not as stiff as shorter ones. The more the stylus bends or
deflects, the lower the accuracy. When you wish to obtain optimum accu-
racy and repeatability, long styli and extensions should be avoided.

Figure 22
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Startup Tutorial

Working with the “Smart” Cards
Welcome to the startup tutorial. The best way to learn the RefleX software
is to try it. Before proceeding we suggest that you read chapter 1:
“Introduction to Coordinate Metrology”. Although it may seem like there
are many steps to starting the system, most experienced users can do this
quite quickly.

1. Turn the system off via the switch located at the front left corner of
the controller.

Controller: card installation location

2. If currently inserted, remove the two “smart cards” from the
controller by pressing the eject buttons located at the front of the
controller.

3. The card on the left in the picture below is the upper “software” card
where the system’s software resides. The card on the right is the
lower “storage” card, where your programs are stored.

Software CardStorage Card

4. Flip the software card over and note the version number on the back.
Reinsert the storage card in the bottom, and the software card in the
top.

5. Turn the RefleX controller on. If this is a DCC system, turn the
machine’s controller (FB-PC) on first, then the RefleX controller.
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Startup Tutorial

Loading the Software
6. For the first 10 seconds, the system’s screen may flicker as the

controller performs a self-diagnosis. This is completely normal. After
successful completion of this self-diagnosis, the system will begin to
load the RefleX software. This software loading process will take an
additional 1 minute.

7. If the self-diagnostic test fails, the “Frown face” (or the “skull &
crossbones” in older controllers) icon appears. Normally this means
that a hardware error has occurred inside the controller. However,
there are other causes. See Chapter 11 “Troubleshooting” for more
information.

TIP: With multiple storage cards, you may “hot swap” the lower
cards. That is, remove and insert cards while the power is on.
These additional storage cards may be purchased through Brown
& Sharpe only!

8. If the system cannot load the software, the “Insert Card” icon will
appear. This is often caused by accidently swapping the software and
storage cards. Fortunately, this will not damage the controller.

9. Ten seconds into the software loading process, the copyright screen
appears. Notice the software version number located in the upper left
corner. Notice also, the web address in the center of the screen. This
support site contains information such as release notes, frequently
asked questions, and supplemental documentation. In addition, you
can always send e-mail to reflexsupport@us.bnsmc.com. If your
system is equipped with an Air Saver, the air will be turned on at this
time.

“Frown Face” icon

“Insert Card” icon

Optional Air Saver

Copyright Screen
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Startup Tutorial

The Language Screen
10. The Language Screen appears next and a tune is played. The

languages currently supported are: English, German, Italian, French,
Spanish, Portuguese, Swedish, Finnish, Polish, Dutch, Danish,
Czech, Simplified Chinese, Traditional Chinese, Japanese & Korean.
For a unilingual environment, you can disable this screen in page 1 of
the system options. If disabled, the system proceeds to the home
screen.

Language Screen

Select down - Moves the highlighted selection
down.

Select right - Moves the highlighted Selection
right.

Done - Accepts the current selection and
proceeds to the next screen.

11. Try moving the Zmouse, located on the Z rail, up and down. Notice
how moving the Zmouse highlights different buttons, or softkeys, on
the screen.

Abort

Select
(Up Down)

Press Selected
Softkey

(often ‘Done’)

ZmouseTIP: You can operate virtually the entire system from the Z-
Mouse. Note: On a desk mouse, these buttons are reversed.

12. Select the desired language and press the Done softkey.
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Startup Tutorial

The Volcomp Screen

Important: Once the (upper) software card has been installed, there is no
reason to remove it, except in the case of a software update.

13. When using machines other than DCC or Arms, it is possible
that a volcomp problem screen may appear. If this screen is displayed,
consult the Troubleshooting, Chapter 11 before proceeding!

Volcomps Mismatch Screen

Important: Never swap software cards between systems. Because the
volcomp file is stored on the software card, as well as the controller,
moving the software card to a new controller can cause problems which
will require a service call!

Tip: It is not necessary to power down the system between measurement
jobs. The system uses less electricity than most household light bulbs!

Startup Tutorial

The Home Screen

Serial Number - For non-DCC and non-arm systems, this number must
match the serial number of the machine. If it does not, contact your local
service representative, as accuracy will be affected.

System Options - This area, described in Chapter 10, allows you to set
options such as volume, contrast, machine type, etc.

Service Utilities - For service personnel only in the event of a problem.

Machine - The correct machine must be chosen in the system options. If it
is not, part drawing scaling will not work correctly.

Done - Tells system the machine is homed and to move to the next screen.

14. The next screen to appear will be the home screen which
prompts you to perform the homing process. As shown on the screen,
move the machine to the upper left front position. Locking the XYZ
airlocks is recommended at this point. Because the Z-Mouse will be
hidden inside of the Z-rail, the Done button must be pressed on the
controller’s keypad.
14. The next screen to appear will be the home screen which
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prompts you to perform the homing process. Stand in back of the machine
and move it to the upper, left, back position. Locking the XYZ airlocks is
recommended at this point. Press the done softkey to continue.
14. The next screen to appear will be the home screen which
prompts you to perform the homing process. Rotate all of the arm’s joints
until all red LEDs turn off. Press Done to continue.
14. The next screen to appear will be the home screen which
prompts you to perform the homing process. Press and hold the “Mach.
Start” button on the jog box until the green light turns on. Press the “Go”
Softkey when ready. The “Homing In Progress” screen will be displayed
as the machine moves around the volume searching for the home position.

XYZ Air Locks

Go

Important:  Failure to properly home the machine will result in reduced
accuracy as well as improper part drawing scaling.

Startup Tutorial

Probe Qualification: Select a Probe
Next, unless a “startup probe” has been saved previously, the system will
prompt you to qualify a probe. Now we will simply qualify a Touch
Trigger Probe, or TTP, but you can refer to Chapter 5, “The Measurement
Mode” for more information. The “Select Probe Type” screen, shown
below, is the first screen in the probe qualification sequence.

Abort - Returns you to home screen.

Scroll up - Moves highlighted selection up.

Scroll down - Moves highlighted selection down.

Cycle option - Allows you to change option.

Done - The current probe settings are accepted and the qualification
process will continue.

Select Probe Screen

15. Leave all settings at their default values (as shown) and select
the Done softkey.

16. If you have not already done so, clamp (bolt) the qualification
sphere to the table as shown below. Pick a spot where the qualification
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sphere will not interfere with measuring parts.

Qualification Sphere Location

Startup Tutorial

Probe Qualification: Locating the Sphere
17. If currently inserted, remove the probe from the end of the Z-
rail. Place the cup in the bottom of the Z-rail on the qualification sphere as
shown. At this point, it is recommended, that you lock the axes with the
air locks. Press the Done softkey to continue.

Remove Probe Screen

Important: Make sure the TTP probe displayed in these screens matches
the one you are actually using. If it doesn’t, be sure to switch probe types
in the system options, page 4.

Important: To make the probe qualification process more efficient, the
“Remove Probe” screen is not shown in subsequent qualifications. Since
the system knows where the qualification sphere is located, there is no
need to tell it the sphere’s location again. Because of this, if the sphere is
moved, you must reboot the system and locate the sphere again. Failure to
follow this procedure will result in faulty probe offset values.

Two TTPs: The TP-ES (left) and the TP-MIP (right)

Startup Tutorial

Probe Qualification: Inserting a Probe

18. Reinsert the probe as shown in the screen. The probe locking
mechanism must be secure. Use a stylus key to tighten the stylus securely.
Press the Done softkey to continue.

Insert Probe Screen

Important: Do not use paper clips in place of stylus keys. Stylus keys are
designed to bend before high torque forces break probes. Replacing a
stylus key is always preferable to replacing a TTP.

Probe Locking Mechanism

Using a Stylus Key

Startup Tutorial
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Probe Qualification: Measuring the Sphere

Important: When taking a point, do not overtravel the probe. Probe
damage can occur after just a couple of millimeters of travel!

Measure Sphere Screen

19. Begin taking points as shown above. Notice the approach
vectors. They are perpendicular to the surface of the sphere. The lengths
of the approach vectors have been exaggerated for demonstration
purposes. Whenever measuring any feature, always allow at least 1 probe
radius of approach vector. After taking the first point, the “Measuring
Qualification Sphere” screen is displayed. After taking 12 points (27 on
arm machines), press the Done softkey to continue. The Done button will
remain dimmed, or disabled, until at least 4 points are taken.

Abort

Note: Because the system knows that we are about to measure a sphere
here, only 4 points are required. Later, during normal measurement
operation, the feature recognition engines require at least 10 points for
spheres.

Clear Last Hit
Done

Tip: Use the “Clear Last Hit” softkey to clear the previous hit as opposed
to using the Abort key to clear all hits.

Startup Tutorial

Probe Qualification: The Probe Summary Screen
20. At this point, the “Probe Summary” Screen will be displayed.
Check the diameter and form error. Try to get below 10 microns form
error for your tip and within 5 microns on the diameter. If your values are
too high, press the “Remeasure Sphere” softkey and try again. Otherwise,
press the Done softkey. If this is a DCC machine, the system will now go
back and remeasure the qual sphere in DCC mode.

Tip: If you are planning on using the same probe for multiple sessions,
you may want to save a “startup probe”. To do this, go to the second page
of the System Options and set the “Startup Probe” from “Qualify” to
“Saved”.

Remeasure Sphere
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Qualify Additional Tip
Done

Probe Summary Screen

Troubleshooting: If your probe’s diameter is consistently high or low, it
could be because the qualification sphere’s diameter is set incorrectly.
Check the diameter stamped on the side of the sphere. Then check that the
“Qual Sphere Dia”, found in page 2 of the System Options, is set
correctly.

Troubleshooting: If you are consistently getting “Can Not Solve” errors at
this screen, it is probably because the system is not seeing movement in an
axis. See chapter 11 “Troubleshooting” for more information.

Tip: When qualifying a disk probe, follow the same procedure as describe
previously, being careful not to shank the probe. Be sure to move slightly
in Z also. Otherwise the system will compute a circle instead of a sphere,
resulting in a “Can not solve” error screen.

Good
Bad

Startup Tutorial

The System Modes Screen

21. At this point, the “System Modes” Screen is displayed. The first
5 softkeys represent different measuring modes. If you do not see all the
modes shown here, it is because they have been disabled in the System
Options, page 5.

Note: The Dial Indicator and XYZ Counters/Scribe mode will remain
dimmed unless a hard (ball) probe is qualified.

System Modes Screen

Tip: Turn off the modes you don’t use. This will help alleviate confusion
when starting the system.

Tip: The “System Startup” button, located below the “Help” button will
bring you back to the “System Modes” screen. If the system is in a state
unknown to you, it will help you get where you want to be. This feature
helps you to simply “Step up and measure”. Note: If the system has not
been homed, this button will bring you to the “Home” screen.
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The System Startup Button
The Help Button

Startup Tutorial

System Modes Screen
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The Measurements Mode

Measuring a Cone
How to measure a cone:

• Unlock all 3 machine axes.
• Approach perpendicularly to the surface of the cone.
• When the probe comes in contact with the surface, you will hear a

beep. You will also see the probe light go out and the "Touch Trigger
Preview Screen will appear.

• Take at least 10 points at different depths. Do not overtravel the probe.
The "TTP Preview Screen" should show a cone after 10 points have
been taken.

• Press the Done softkey or the right button on the Z-Mouse to continue.
• Lock the machine axes.

25. Measure cone #17 at the lower
left of the demo block as shown.

TTP Preview Screen
One possible method
of measuring a cone
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4-3 Alignment 1: Line Line Intersect
4-4 Alignment 2: Circle Circle Centerline
4-5 Translating an alignment
4-6 Rotating an alignment

CHAPTER 4

Alignments
Tutorial
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Alignments Tutorial

This Measurement mode lab is a continuation of the "Measuring Features
Tutorial". You are already in the measurement mode with the RefleX demo
block clamped down and a single tip TTP qualified. The focus of this lab is to
get you comfortable with the alignment function.

1. Begin by resetting to clear features measured during Measuring Tutorial.
Press in succession the softkeys "Tools", "Reset Measurement Mode" and
"Done".

Line Line Intersect Alignment
It is rarely possible to manually align a part exactly to a machine. However, a
part can be aligned by measuring features and assigning datum designations to
those features (A, B, C).

Important: It is important to remember the Datum A, B, C sequence
which you will use 99% of the time. Datum A, C, B, is also allowable.
All other variations of the datum ABC sequence will result in inaccurate
measurements!!!

2. Measure plane #1 on the top of the
demo block as instructed in the Measuring
Features Tutorial. Press the "Datum A"
softkey.  The part is now "leveled"!

3. Measure line #2 on the front of the
demo block. Press the "Datum B" softkey.
The part is now "clocked"!

4. Measure line #3 on the side of the
demo block. Press the "Relationships"
softkey to display the intersection point.
Press the "Datum C" softkey. The origin is
now set and the alignment is complete.

Datum A

Datum B

Datum C

Reset Measurement
Mode

Tools
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Alignments Tutorial

5. With the alignment complete, move the probe tip to the upper, left,
front corner of the part. Notice the counters are near 0.000, 0.000,
0.000. If the part had been clamped at an angle, you would see that as
you move the probe along the front side of the demo block, the X axis
counter would increment while the Y axis would remain unchanged.

Tip:  For more complicated parts, you can use the power of alignments
to your advantage. While this part's alignment is easy to visualize,
parts with compound angles and odd datum surfaces are not. If the
system can measure a part in one orientation, it can also measure it in
a different orientation. If you are having trouble writing a program,
align the part so it is easy to visualize. When you have the desired
results, rewrite the program for the orientation that facilitates part
clamping.

Another alignment:
This time align the block by setting datum B on the line between two holes.
Set the origin at the center of a bore.

6. Reset the measurement mode as instructed in step 1.

7. Measure the top surface of the demo block again as instructed in step 2.

8. Measure circle #16.  Measure circle #15.  Press the "Relationships"
softkey and scroll to the "Line Through Centers" screen.  Press the
"Datum B softkey".

9. Measure the center circle #4.  Press the "Relationships" softkey to
toggle back to single feature mode.  Press the "Datum C" softkey.  The
alignment is complete.

Note:  Under normal circumstances,
there is no need to save the datum.
The current alignment is active until
you do another datum operation. Most
of the time, the only reason for saving
and recalling a datum is to transfer an
alignment to another measuring mode,
such as the Dial Indicator Mode.
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Alignments Tutorial

Note:  For more information on how a datums are used with a particular
feature, see Chapter 5.

Translating an alignment:
Some part drawings have features dimensioned from a constructed feature,
such as a symmetry point. Because this point cannot be measured directly, it
must be constructed by measuring two other features. To translate the align-
ment to this symmetry point, use the "Translate to Last Feature" function
where the last feature is the symmetry point.

Other part drawings have features offset from a particular point. For example,
1 mm in from the edge of the part. To translate the alignment to this point, use
the "Translate by Offset" function.

10. To construct a symmetry point between the two small circles (#16, #15)
just measured, press the "Tools" softkey, the "Construction" softkey, the
"Symmetries" softkey, and the "Symmetry Point" softkey.  Select features
3 and 4.  Press the Done softkey.

11. To translate the alignment to this symmetry point, press the "Tools"
softkey, the "Datum" softkey, and the "Translate" softkey.  Leave the X, Y,
and Z axes set to "Last Feature". Press the Done softkey. The origin has
moved to the centerpoint between the two circles.

Tools

Construction

Symmetries

Symmetry Point

Datum

Translate
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Rotating an alignment:
Unlike the demo block, some parts are aligned at specific angles. For
example, a part must be aligned 45 degrees from an edge. To do this use the
"Rotate by Angle" function. For the example, align the block 45 degrees
from the centerline between the two bores (Our old datum B).

12.  To rotate the alignment, press the "Tools" softkey, the "Datum" softkey
and the "Rotate" softkey. Leave the "Rotate About" axis set to "Z".
Enter a rotation angle of 45 degrees and press the Done softkey.
Check the alignment. As you move the machine in a 45 degree angle,
only the X counters should change while the Y counter remains
unchanged.

Note:  Instead of a specific angle, such as 45 degrees, some drawings
specify two rotation offsets such as 2 mm and 3 mm. In this case you
do not have to calculate the angle. The system will do it for you! Leave
the rotation angle blank and key in the offsets in the "Value" fields
below. After entering the second offset, the system will display the
rotation angle.

Alignments Tutorial
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5-3 The TTP Preview Screen
5-4 The Hard Probe Scanning Screen
5-5 Measurement Results Screen
5-6 The Status Bar
5-8 Measurement Mode Softkeys
5-9 Change Feature Type
5-10 Set Level
5-11 Set Axis
5-12 Set Origin
5-13 Delete Last Block / Store Relationships
5-14 Tolerancing Results
5-16 GD&T Symbols
5-17 The Tools Menu
5-18 The Tools Menu - Probes
5-20 The Tools Menu - Datums
5-21 The Tools Menu - Construction
5-24 The Tools Menu - Relationships
5-25 The Tools Menu - Statistics
5-26 The Tools Menu - Part Drawing
5-27 The Tools Menu - Playback Utilities
5-33 Reference Features, Headers, Service Utilities

CHAPTER 5

Measurement
Mode
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Measurement Mode

Abort Current
Measurement

All measurement
points will be deleted.

Total Number of Points
Shows the number

of points taken.

Done With Current
Measurement

The system will
determine automati-

cally the type of feature
you just measured and
display the Measure-
ment results Screen.

Current Feature
The arrow points to the

feature type you are
currently measuring.

The system determines
the type of feature based

on the measurements
you are taking.

Remember that in order
to measure a feature of a

given type, you must
take at least the

minimum number of
points for that feature.

Status Bar
Shows the various
icons that tell you
about the status of
the system. (Addi-
tional Icons may be

displayed.)

Minimum Points
Required

Shows the minimum
number of points

required in order to
solve the desired

feature.

Delete Last
Measurement

The last measurement
point will be deleted.

Velocity Bar Speedometer
Shows the probe velocity.  You
should keep it in the "Good"

area! Recall Tip
Allows the operator
to switch to another

tip on a MIP.

Form Error
Shows the form error as

you take measurements of
the feature. The form error
is represented as a black

bar ranging from 0 to 50. If
the form error is greater
than 50 microns, the bar
will be completely black.

The TTP Preview Screen
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Measurement Mode

Total Number of Points
Shows the number of

measurement points you
have taken. Remember

you must take at least the
minimum number of

points per feature type as
follows:

Feature Points Req.
Point 1
Line 2
Plane 3
Circle 3
Cylinder 10
Cone 10
Sphere 10

Status Bar
Shows the various icons that tell you

about the status of the system.
(Additional Icons may be displayed.)

Done With Current
Measurement

The system will
determine automati-

cally the type of feature
you just measured and
display the Measure-
ment results Screen.

Measurement Speedometer
Shows the velocity of the probe as
it moves along the surface of the
feature. Try to keep the bar in the

"Good" area!

Abort Current
Measurement

All measurement
points will be deleted.

Delete Last
Measurement

The last measurement
point will be deleted.

The Hard Probe Scanning Screen
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Measurement Mode

Measurement Results Screen
After a measurement has been taken, the system determines the feature's
properties and displays them as shown below.

Probe Location

Part Drawing
Window

Measurement Results

Status Bar

Current Screen Total Number
of Screens

Available
Softkeys

Feature List

Current Screen The identification number of the current screen.

Total Number The total number of possible screens. Use the right
of Screens arrow softkey to view the other possible screens.

Probe Location The XYZ coordinates of the probe's center. This
location is also shown graphically as the "flying probe"
in the Part Drawing Window.

Feature List This list displays the current and previous features.
Only the last 100 features are saved for playback.

Part Drawing This window displays a drawing of the measured
Window features. The system automatically scales this drawing,

based on the selected machine type, to fit the area.

Status Bar This area represents the current status of the system's
probes, datums, etc.

Measurement The computed results of a measured feature, such as
Results diameter, form error, or true position, are displayed.

Time Units
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Measurement Mode

Probe Status Screen Counter

Active Datum

Projection Plane            Status of Outputs

Probe Status Indicates the current active probe / probe tip. The probe
status icons are:

Hard probe, or TTP tip number 1 is currently
active.  Up to 9 TTP tips may be qualified.

Edge probe with zero diameter

Tapered probe

Optical Probe

Datum Status Indicates the current datum  system. The datum status
icons are:

No datum system active. The system is using the
machine coordinates.

The datum system has been modified but not
saved.

Up to 9 datum systems can be created. These
systems can be saved and recalled within the
same inspection.

The Status Bar
The Status Bar displays information about the current state of the system.

1

1-9
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The Status Bar

Measurement Mode

Projection Plane Indicates the plane into which the feature was projected.

The feature was projected into the Top (XY) plane

The feature was projected into the Side (YZ) plane

The feature was projected into the Front or Back
(ZX) plane

Output Status Indicates the status of output devices. Once a block is sent
to an output device, selecting it again will disable the output
during the playback mode. The output devices are:

Output to printer

Output to internal statistics

Output to serial port

During playback, pause to view measurement
results.

Note:  These outputs are configured in page 3 of the system options.  See
section 10-11 for more info.

Screen Displays the current screen, as well as the total number of
Counter possible screens.

Feature List Blocks
After a feature has been measured, the system assigns it a sequential number
and stores it in the feature list.  The system also stores other functions such as
probe qualification and datums manipulations in the feature list.  A maximum
of 100 program blocks are stored for playback.  After the 100th block, you
will still be allowed to continue measuring, but, if you decide to save this
program, only the last 100 features will be stored.
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After a feature has been measured, the system will display various results
screens.  These screens have the following softkeys available:

Single Feature Display Mode
When this softkey is toggled to "Single Feature", only the results of the
previous measured feature are displayed.

Relationship Display Mode
When this softkey is toggled to "Relationships", the calculated results between
the previous 2 features are displayed.

Scroll Up
This softkey lets you display the results of previous features by scrolling back
through the Feature List.

Next Screen
This softkey brings you to the next available result screen. Notice the status
bar's screen counter increment as this softkey is pressed.

Tolerance
When this softkey is pressed, the system displays a screen for entering
nominal and tolerance information.

Output
This softkey can do multiple operations: Print (shown), serial out, send to
internal statistics, playback stop, or any combination of these 4 options.

Lower Menu
When this softkey is pressed, you are brought to the lower result screen menu.

Upper Menu
When this softkey is pressed, you are brought to the upper result screen menu.

Tools Menu
This softkey displays the system's "Tools" menu. Operations such as construc-
tions, probe qualifications, and Relationship between 2 non-sequential features
can be executed from this menu.

Measurement Mode Softkeys

Single Feature

Scroll Up

Next Screen

Tolerance

Output

Lower Menu

Upper Menu

Tools Menu

Note:  For more information about Measurement Mode softkeys, see
Chapter 3's Measurement Mode Tutorial.

Relationships
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Measurement Mode Softkeys

Change Feature Type
The Change Feature Type softkey allows you to override the system's feature
recognition results for the last measured feature. For example, the system
solves the measured feature as a circle when the operator really meant for the
feature to be a cylinder.

The following table summarizes the features that can be changed into other
features:

Change Circle

Abort

Make It A Cylinder

Make It A Plane

Make It A Line

Make It An Inside Circle

Make It An Outside Circle

Delete It

Change Feature
Type

When the Change Feature Type softkey is selected, the system displays a
screen similar to the following:

 Line  Circle   Plane       Cylinder  Cone

Line  X    X
Circle  X    X     X
Plane  X  X
Cylinder  X   X
Cone  X  X    X      X
Sphere    X
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Measurement Mode Softkeys

Set Level:  This softkey creates new reference plane (Datum A) and corre-
sponding major and minor axes from the measured features.

Feature Type Description

Any Point Because a point has no direction component
(vector), this option is disabled.

Any Line* For a line, this softkey rotates the reference plane
(Datum A) to the line's perpendicular. Also, the
origin is projected into the new reference plane.

Plane For a plane, this softkey rotates the Datum A to
the measured plane. Also, the origin is projected
into the new reference plane.

Circle Because a circle has no direction component
(vector), this option is disabled.

Cylinder For a cylinder, this softkey rotates the reference
plane (datum A) to the plane perpendicular to the
cylinder's centerline.  The origins are also
translated to the cylinder's pierce point.

Cone For a cone, this softkey rotates the reference plane
(datum A) to the plane perpendicular to the cone's
centerline.  The origin is also translated to the
cones apex.

Sphere Because a sphere has no direction component
(vector), this option is disabled.

* Note:  For a measured line, the level (third axis zero point) is set at the
centroid of the points taken to create the line. Setting a known origin (datum
C) is suggested.

Set Level
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Measurement Mode Softkeys

Set Axis:
This softkey rotates the current datum system to the current measured feature
(Datum B).  The datum axis closest to the measured feature is rotated. The
general direction (sign) of the datum axis is not changed.

Feature Type Description

Any Point This option is disabled because a point does not
have a direction component (vector).

Line This softkey projects the line into the current
Datum A, then rotates the closest datum axis to be
parallel with it.

Plane This softkey projects the line perpendicular to the
plane into the current Datum A, then rotates the
closest datum axis to be parallel with it.

Circle This option is disabled because a circle does not
have a direction component (vector).

Cylinder This softkey projects the cylinder's centerline into
the current Datum A, then rotates the closest datum
axis to be parallel with it.

Cone This softkey projects the cone's centerline into the
current Datum A, then rotates the closest datum
axis to be parallel with it.

Sphere This option is disabled because a sphere does not
have a direction component (vector).

Set Axis
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Measurement Mode Softkeys

Set Origin:
This softkey translates the origin (Datum C) of the datum system as follows:

Feature Type Description

Any Line or Plane Because there is no repeatable single point created
by a line or plane, this option is disabled.

Measured Point Translates the origin to the point's tip compen-
sated location.

Constructed Point Translates the origin to the point's location.

Point Measured Translates the origin to the point's location.
with Tapered Probe

Circle Translates the  origin to the circle's center.

Cylinder Translates the origin to the cylinder's pierce point.

Cone Translates the origin to the cone's apex.

Sphere Translates the origin to the sphere's center.

Set Origin
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Measurement Mode Softkeys

Delete Last Block
This option deletes the last program block. The block can be a measured
feature or a system function. When you delete a non-feature block, the system
restores the previous block values as follows:

Block Type Operation
Any Feature Feature is deleted
Probe Qualification Qualification file is cleared

Probe from last block is recalled
Recall Tip Probe/Tip from last block is recalled
Tapered Probe Probe from last block is recalled
Save Datum Saved datum is cleared

Recall datum from previous block
Recall Datum Recall datum from previous block
New Level Recall datum from previous block
New Axis Recall datum from previous block
New Origin Recall datum from previous block

Store Relationships
This option is only available when the current displayed relationship creates a
feature. The relationship is stored at the end of the feature list.  The following
are the relationships that create a feature:

Relationship Description
Point/Point 2D Line & Midpoint
Line/Line Intersection Point & Midpoint
Line/Plane Intersection Point
Line/Circle Intersection Points
Line/Cylinder Halfway Point
Line/Cone Halfway Point
Plane/Plane Intersection Line
Plane/Circle Intersection Points
Plane/Cylinder Pierce Point
Plane/Cone Pierce Point
Plane/Sphere Intersection Point
Circle/Circle 2D Line & Intersection Points
Circle/Cylinder 2D Line
Circle/Cone 2D Line
Cylinder/Cylinder Halfway Point
Cylinder/Cone Halfway Point
Cone/Cone Halfway Point
Cone/Sphere 3D Perpendicular Line

Delete Block

Store Relationship
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Measurement Mode

Tolerancing Results
To tolerance a feature result, nominals and tolerance values must be entered in
the tolerance screen shown below.

Tolerance

Change Tolerance

Current Result

Output Format
Nominal
Tolerances

Next Result

Result Description

Next Item

The output choices are as follows:  "Measured" (default), "Full", "Tol. Band",
"Out of Tol.", "None". Each choice changes the display on the screen, as well
as the "Print Format" style printout / serial output.  When this value is set to
"None", that result disappears from the screen and will not be printed or sent
out of the serial port.

The softkeys available in the tolerance screen  are as follows:

Abort
The system discards the changes made in the tolerance screen and returns you
to the Result screen.

Next Item
This softkey advances the highlight to the next item (Output, Nominal, Upper
Tol., Lower Tol.).

ISO Tolerance Table
This softkey is only available when entering tolerance information for circle
or cylinder diameters.   The system displays ISO Tolerance Codes and Grades
based on the nominal size of the circle or bore and whether the measurement
is internal or external (bore or pin).

Next Result
This option advances the highlight to the next result.

Abort

Next Item

ISO Tolerance

Next Result
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Measurement Mode

Keyin Value:
This softkey is used for entering nominal and tolerance values. Use the +1, -1,
and +/- softkeys, followed by the Done softkey to change a nominal or toler-
ance value.

Done:
All changes are accepted and you are returned to the Measurement Mode result
screen.

Important: The system will approximate the nominal value based on the
measured value using the "Nom. Nearest" option in the system options.
The next time a similar feature is measured, the system will reuse the
nominal used the previous time.

Cycle Option
In the tolerance screen, the cycle option softkey is used to choose the desired
tolerance type. Below are examples of the 5 tolerance types in "Print Format:"

Cycle Option

0.0 05
+

Keyin Value

Done

Measured:
==> Circle (1)
..: Circle
Diameter
15.018

Tol Band:
==> Circle (1)
..: Circle
Diameter
===*===

None:
(The value is not
outputted or displayed
on the screen)

Full:
==> Circle (1)
..: Circle

                 MEASURED      NOMINAL    UPPER TOL  LOWER TOL  DEVIATION  OUT/TOL

Diameter              15.018       15.018      0.020     -0.020     -0.000
===*===
Out-Of-Tol:
==> Circle (1)
..: Circle

                 MEASURED      NOMINAL    UPPER TOL  LOWER TOL  DEVIATION  OUT/TOL

Diameter              15.018       15.018      0.020     -0.020     -0.000
===*===
(Same as Full format except the results are only outputted when the feature
is out of tolerance.)

Note:  For a listing of all of the serial outputs, see section 10-12
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Measurement Mode

Location along the X axis
Location along the Y axis
Location along the Z axis
Polar coordinate - radial distance from the origin
Polar coordinate - angle with major axis of ref. plane
Diameter
Radius
Length of slot
Width of slot
Distance along X axis between two features
Distance along Y axis between two features
Distance along Z axis between two features
2D distance between two features along the Top (XY) plane
2D distance between two features along the Side (YZ) plane
2D distance between two features along the Front or Back (ZX) plane
3D distance between two features
Perpendicular distance between two features
Perpendicular distance between a feature and the origin of the datum
Form error: roundness
Form error: flatness
Form error: straightness
Form error: cylindricity
Form error: cones and spheres
Included angle with X axis
Included angle with Y axis
Included angle with Z axis
Included angle with Top (XY) plane
Included angle with Side (YZ) plane
Included angle with Front or Back (ZX) plane
Included angle between two features
True position: MMC with diametrical tolerance zone
True position: RFS with diametrical tolerance zone
Perpendicularity or squareness
Parallelism
Angularity
Concentricity with diametrical tolerance zone

 Symbol Result Description
X
Y
Z
U
V
Ø
r
L
W
∆X
∆Y
∆Z

∆XY
∆YZ
∆ZX

∆XYZ
∆
∆

   X
   Y
   Z

   XY
   YZ
   ZX

Ø     M
Ø      S

    Ø

GD&T Symbols
The results of most measurements are referenced with a GD&T (Geometric
Dimensioning & Tolerancing) symbol.  The following is a description of
GD&T symbols that the system uses:
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Tools Menu:  Abort:
When this softkey is pressed, all changes are aborted and you are returned to
the Measurement Mode.

Tools Menu:  Reset Measurement Mode:
The Reset Measurement Mode softkey is used to clear completed work by
restoring the Measurement Mode to default conditions.  After the Reset
Measurement Mode screen appears, press the "Done" softkey to reset the
system or "Abort" to cancel.   When the Measurement Mode is reset, the
following operations are performed:

1. Delete All Features
2. Clear the Datum
3. Activate Probe Tip 1
4. Reset Statistics
5. Reset Tolerances

Reset Measurement
Mode

Abort

Tools

The Tools Menu is accessed by pressing the tools softkey in Measurement
Mode. The menu is in two levels:

                          Upper Menu             Lower Menu
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The Tools Menu - Probes

Tools/Probe Menu:  Select Probe Type
The probe menu's "Select Probe Type" softkey is used to qualify a probe.  A
probe can be qualified with a qualification sphere or by keying in the
probe's diameter and offsets.  In addition to the probe qualification steps
listed here, you should review the Startup Tutorials probe qualification
procedure in Chapter 2.

1. Select the probe type from the following list:

TTP:   Touch trigger probe
Ball probe ac:   Solid probe with spherical tip (hard probe)
Taper probe  abcd:    Solid probe with conical tip
Edge probe  abcd:  Solid probe with flat edge
Optical probe  abcd: Camera style probe with monitor
Scribe probe  acd :   Solid probe with sharp tip.

a - Not currently available for Mistral machines.
b-  Not available on horizontal machines.
c-  Can not be used in DCC playback on DCC machines.
d-  Not available on arm machines.

Note:  For a picture of each of the above probes, see appendix 4-2.

2. By default, when the diameter and offsets are set to "Qualify", the
system will automatically calculate those values.  But, by using the
change option softkey, you can key in values for the diameter and
offsets.  The offsets are measured from the bottom of the Z rail to the
center of the probe tip.  With a MIP, the offsets is to the center of the
first tip.

3. The system will now guide you through the probe qualification
process using the following screens:

a.  The "Remove Probe" & "Locate Sphere" screen
b.  The "Reinsert Probe" screen
c.  The "Measure Sphere" screen
d.  The "Qualification Results" screen

Probes

Select Probe Type
(Begin Qualification)

0.0 05
+

Keyin Value

Change Option
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The Tools Menu - Probes

4. While measuring the qualification sphere, it is recommend that you take
at least 12 points as described in the Startup Tutorial's Chapter 2.

Troubleshooting: If you are consistently getting "Can Not Solve" errors
in the probe qualification screen, it is probably because the system is not
seeing movement in an axis. See Chapter 11, "Troubleshooting" for
more information.

5. After you are done measuring the sphere, the system displays the
qualification results screen.  If the results are not satisfactory, press the
"Remeasure Sphere" softkey. If you have a multi-tip probe, press the
"Qualify Next Tip" softkey to qualify an additional tip.

Note: - When qualifying a multi-tip probe, record the probe tips
orientation. This information will be needed during measuring.

Tools/Probe Menu:  Recall Probe Tip
This softkey lets you recall a previously qualified probe tip when using a
multitip probe. When this softkey is selected, the Recall Tip screen is displayed.
Use the arrow softkeys to select the desired tip number. Note:  For multitip
probes, the current active tip number is displayed in the status bar.

Tools/Probe Menu:  Qualify Additional Tip
With a multitip probe, this option allows you to qualify a new tip.

Tools/Probe Menu:  Save Startup Probe
This softkey allows you to save a startup probe. This feature tells the system to
skip the startup sequence's probe qualification the next time the system is
started. This function can also be accessed from screen 1 of the System
Options.

Probes

Next Tip

Remeasure Tip

Save Startup Probe

Recall Tip

Qualify Additional Tip
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The Tools Menu - Datums

Tools/Datum Menu:  Save Datum
This softkey lets you store the current datum for later use. With the exception
of transferring datums to other measuring modes, if you plan the measurement
sequence correctly, this softkey is seldom used.

Note: When the power is turned off, the saved datums are lost.

Note:  Many first time operators use the Save Datum softkey incorrectly.
After an alignment, you do not need to save a datum unless you plan to do an
additional alignment, and then return to the current alignment.

Tools/Datum Menu:  Recall Datum
This softkey lets you recall a previously saved datum. In addition to user-
created datums, you can also recall the machine datum system.

Tools/Datum Menu:  Translate Current Datum
This softkey lets you translate the origin to a keyed in location or the location
of the last measured feature. A value of 0 in a particular axis will cause that
axis not to be translated.

Tools/Datum Menu:   Rotate Current Datum
This softkey lets you rotate the current datum system. You can use a keyed in
angle, or keyed in offsets to achieve the desired rotation.

Note: After the 2 offset values are entered, the system displays the calculated
rotation angle.

Note: In playback, the operations listed above will be executed automatically.

Datum Menu

Save Datum

Recall Datum

Translate Datum

Rotate Datum
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The Tools Menu - Construction

To construct a feature:
1. Measure the features needed for the constructed feature.
2. Select the desired construction softkey from the Construction Menu.
3. Use the arrow softkeys to move the highlight over the features to be

used in the construction and press the Select key. Press the key a second
time to deselect a feature. As a feature is highlighted, a cross is dis-
played over that feature in the part drawing window. When the feature is
selected, it is remarked with a double cross.

4. When features are selected, press the Done softkey to construct the
desired feature.

Tools/Construction Menu:  Constructing a Line
This softkey lets you construct a line through the center of previously measured
features. For a given feature, the system constructs a line as follows:

Feature Type Description
Point Uses the XYZ location of the measured point
Circle Uses the XYZ of the center of the circle
Cylinder Uses the XYZ of the pierce point of the cylinder
Cone Uses the XYZ of the pierce point of the cone
Sphere Uses the XYZ of the center of the sphere

If all selected features were projected into the same reference plane, a 2D line
will be created in that plane.

If all selected features weren't projected into the same reference plane, you will
be asked to select a reference plane or to make it a 3D line.

Construction

Select Feature

Construct a Line
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The Tools Menu - Construction

Tools/Construction Menu:  Constructing a Circle (Bolt Hole Pattern)
This softkey lets you construct a circle through the center of previously
measured features. For a given feature, the system constructs a circle as
follows:

Feature Type Description
Point Uses the XYZ location of the measured point
Circle Uses the XYZ of the center of the circle
Cylinder Uses the XYZ of the pierce point of the cylinder
Cone Uses the XYZ of the pierce point of the cone
Sphere Uses the XYZ of the center of the sphere

To construct a circle, follow the procedure on the previous page. If all
selected features weren't projected into the same reference plane, you will be
asked to select a reference plane.

Tools/Construction Menu:  Constructing a Plane
This softkey lets you construct a plane through the center of previously
measured features. For a given feature, the system constructs a plane as
follows:

Feature Type Description
Point Uses the XYZ location of the measured point
Circle Uses the XYZ of the center of the circle
Cylinder Uses the XYZ of the pierce point of the cylinder
Cone Uses the XYZ of the pierce point of the cone
Sphere Uses the XYZ of the center of the sphere

To construct a plane, follow the procedure on the previous page.

Tools/Construction/Symmetries Menu:  Symmetry Point
This softkey lets you construct a point halfway between two measured
features. For a given feature, the system constructs a symmetry point as
follows:

Feature Type Description
Point Uses the XYZ location of the measured point
Circle Uses the XYZ of the center of the circle
Sphere Uses the XYZ of the center of the sphere

To construct a symmetry point, follow the procedure on the previous page.

Construct a circle

Construct a plane

Symmetry Point
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The Tools Menu - Construction

Tools/Construction/Symmetries Menu:  Symmetry Line
This softkey lets you construct a symmetry line through the center of previ-
ously measured features. For a given feature, the system constructs a symmetry
line as follows:

Feature Type Description
Line Uses the XYZ centroid of the line
Cylinder Uses the XYZ of the pierce point of the cylinder
Cone Uses the XYZ of the pierce point of the cone

Tools/Construction/Symmetries Menu:  Symmetry Plane
This softkey lets you construct a symmetry plane through the center of
previously measured features. For a given feature, the system constructs a
symmetry plane as follows:

Feature Type Description
Line Uses the XYZ centroid of the line
Cylinder Uses the XYZ of the pierce point of the cylinder
Cone Uses the XYZ of the pierce point of the cone

Tools/Construction Menu:  Projection Point
This softkey lets you construct a point by projecting a point, circle or sphere
into a line, plane, cylinder or cone. A point type feature (point, circle or sphere)
and a vector type feature (line, plane, cylinder or cone) must be selected.

Tools/Construction Menu:  Construct From Datum
This softkey lets you construct a feature by copying one of the current datum
system components. You can create a point from the origin, a line from one of
the datum axes, and a plane (offset if desired) from one of the datum planes.

Symmetry Line

Symmetry Plane

Projection Point

Construct From
Datum
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The Tools Menu - Relationships

Tip:  Think for a moment. Because Circle 1
and Circle 4 are not new measured or con-
structed features, it does not make sense to
create a new block for them. The system
simply references the existing blocks.

Relationships

Tools Menu: Relationships:
The Measurement Mode's Relationship softkey lets you view the relationship
between the last 2 measured features. This softkey lets you view the relation-
ship between any 2 non-sequential previously measured features.

This function does not operate by creating a new block. Rather, it copies the
first selected block to the end of the list and sets the other as a temporary
reference feature.  Because of this the block sequence may appear out of order.
For example:

Suppose you measured the following sequence:
1.  Circle
2.  Plane
3.  Line
4.  Circle
5.  Cylinder
6.  Cone

After completing this sequence, you would like to see the relationship
between Circle 1 and Circle 4.  Press the Tool menu's Relationships softkey,
select Circles 1 and 4 and then press the Done softkey.  The new sequence
would be as follows:

1.  Circle
2.  Plane
3.  Line
4.  Circle
5.  Cylinder
6.  Cone
1.  Circle
4.  Circle (This is with Relationships turned on)

If you turn off the Relationships softkey before continuing, the sequence
would look like this.

1.  Circle
2.  Plane
3.  Line
4.  Circle
5.  Cylinder
6.  Cone (This is with Relationships turned off)
1.  Circle (Notice that the lower Circle 4 is no longer visible.

 The next measured feature will be block 7.)
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The Tools Menu - Statistics

Tools Menu: Others:
Because not all softkeys could fit into one menu, they have been broken up
into an upper level tools menu and a lower level tools menu.

Tools Menu: Statistics:
The Internal Statistics softkey lets you perform a statistical evaluation on a
number of part measurements. The system provides summary reports, run
charts and histograms of the measured features.

Collecting Statistics Data:
1.  Enable internal statistics using the "Enable Statistics" softkey.
2.  Measure a desired feature.  Press the Add Record softkey. At the

"Adding New Record" screen, press the "Done" softkey.
3.  Continue measuring. Each time a new feature is measured, an

"Adding new Record" screen is displayed. When an existing feature is
measured, an "Adding Observation" screen is displayed.  The system
can store up to 5 records with 100 observations in each.  All measure
ments in a record must be within 10% of the mean value.  If not, a new
record is created.

4.  To delete a record, press the "Delete Record" softkey.

Display Reports and Charts:
1.  Press the "Summary Data" softkey to enter nominal and tolerance

values for the desired features.
2. At any point after you begin taking data, a statistical summary, histo-

gram, or run chart can be displayed.  To do so, select either the
"Summary Data", "Run Chart", or "Histogram" softkeys from the
Statistics menu.

3.  The system now asks you to select a desired feature. Use the scroll up
and scroll down softkeys to select a feature.

4.  Finally, the system will ask you to select a desired characteristic of the
selected feature.  Use the scroll up and scroll down softkeys to select
the desired characteristic.

Copy Mean:
To save time, you can use the "Copy Mean" softkey to copy the computed
mean to the nominal.

Note:  If you desire more advanced statistical functions, consider purchas-
ing an external statistic package such as DataPage TM.

1

0

Statistics

Lower Menu

Upper Menu

Enable Statistics

Add Record

Delete Record

Summary Data

Run Chart

Histogram.

x
Copy Mean
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Tools Menu:  Part Drawing:
From the Part Drawing menu, you can select 2 different methods for making a
printout of the part. The first method involves printing either the top, front, or
side views. The second method, called digitize outline allows you to select
specific regions to be displayed. The softkeys that are available from the Part
Drawing menu are as follows:

Tools/Part Drawing: Print Top View (XY)
When you select the Print Top View softkey, all features measured in the top
plane, as well as all 3D features are printed.

Tools/Part Drawing: Print Front View (ZX)
When you select the Print Front View softkey, all features measured in the
front plane, as well as all 3D features are printed.

Tools/Part Drawing: Print Side View (YZ)
When you select the Print Side View softkey, all features measured in the side
plane, as well as all 3D features are printed.

Tools/Part Drawing: Digitize Outline:
The Digitize Outline softkey lets you print out a specific region of a part in
either the top, side, or front planes.  After this softkey is selected, a "Scan
outline of the part" screen appears. When you complete scanning the outline
of the part, the Print softkey appears.  Press the Print softkey to begin part
printout or the Abort softkey to exit.

Part Drawing Menu

Print Top View

Print Front View

Print Side View

Digitize Outline
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The Tools Menu - Playback Utilities

Playback

Playback overview:
The Playback Mode facilitates the inspection of frequently measured parts.  For
example, if you need to inspect multiple parts, all of which are the same, you
would write a program to aid the measurement process.

Although you may not realize it, ever time you perform a measurement
sequence, you are creating a part program. You simply have not chosen to save
or replay the program.  After completing an inspection sequence, you have 2
choices:

1 Replay the part program immediately (without saving it).
2. Store Program- Store the current inspection sequence for later replay.

Understanding and using the playback capabilities of this software are ex-
tremely important.  Because steps such as manipulating datums, entering
nominal and tolerance information, and outputting results are executed auto-
matically, part inspection time is significantly reduced.  The chances of making
a mistake are also reduced.

Planning the Inspection Sequence
The following should be considered when planning a part inspection:

1. Review the part print and mark all features you wish to measure and
their order. A playback program can have at most 200 blocks. If more
blocks are needed, create and store a separate inspection sequence.

2. Identify all callouts and note datums, nominals and tolerances.
3. Identify the probe tips/orientations needed for this part.
4. For more complicated parts, use the power of alignments to your

advantage. Some part alignments are easy to visualize. Other parts, with
their compound angles and odd datum surfaces, are not as easy.
Remember, if the system can measure a part in one orientation, it can
also measure that part in another orientation.  If you are having trouble
writing a program, align the part so it is easy to visualize. When you
have the desired results in that orientation, rewrite the program in the
orientation which facilitates part clamping.



Chapter 5: Measurement Mode 5-28

The Tools Menu - Playback Utilities

Creating the Inspection Sequence
When the inspection sequence is planned, create it as follows:

1. Enter screen 3 of the System Options to setup the output devices to be
used:  Printer, Serial Output, Playback Pause.  Consider enabling

Statistics also.
2. Clear the system of all previous work by selecting the Reset

Measurement Mode softkey from the Tools Menu.
3. Clamp the part to the table and insert the proper probe.
4. Always start the inspection sequence with a probe qualification block.

This prompts you to qualify the correct probe tips in the correct
orientations.

5. Begin measuring features. Enter nominals and tolerances and output
results. The system will replay these steps in the order they were
measured.

Executing a Playback Program
When the inspection sequence is complete, you can choose to replay that
program by selecting the Playback softkey.  This will not save the program.
The next time you select the Reset Measurement Mode softkey, or the power
is shut off, the program will be lost.

The system will prompt you to measure the required features in the order they
were created.  Blocks that don't prompt you to measure will be executed
automatically.

Blocks which execute automatically:
The system automatically executes the following blocks without prompting:

Reset Measurement
Mode

Playback
(Without Saving)

Datum
Features

Stored
Features

Constructed
Features
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Playback Error Recovery:
When there is an error during the Playback Mode, the system displays the Error
Message screen. The possible playback error screens are:

Error Message Cause of Error Recommended Solution
Can Not Solve The measured element Ensure you are measur-

or relationship could ing the correct element
not be computed Re-execute the current

block

Qualification Failed A computation error Ensure you are measur-
was detected while ing the qualification
qualifying the probe sphere.  Re-execute the

current block

Abort Selected This is not an error. Select the proper option
When you press Abort
from any screen, the
system will display the
error screen so you can
execute a specific block
or exit Playback

Execute Block:
The Execute Block softkey allows you to execute a specific program block.
This softkey is often used to remeasure a block when you are not satisfied with
the previous measurement results.

Exit Playback:
The Exit Playback softkey exits playback and returns you to the Measurement
Mode.

Re-run Program:
The Re-run program softkey appears at the end of a playback program.  Simply
clamp down a new part and press this softkey to begin inspection again.

Re-run Program, Jump to below alignment:
This softkey, is intended for fixture programming.  See Chapter 12 for more
information.

Execute Block

Exit Playback

Re-run Program

Jump to below
alignment
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To Store a Program:
The Store Program softkey allows you to save an inspection sequence to the
storage card.  The program must be 100 blocks or less. To store a program to
the storage card:

1. Verify that the storage card is inserted.  (If you have only one machine,
this card should always be inserted. If you have multiple machines,
storage cards are sometimes interchanged to transfer programs from
one system to another.)

2. From the Tools menu, select Playback Utilities, followed by Store
Program.  Enter a program name that describes the measured part.
Similar to MS-DOS convention, program names can have up to 8
characters, with no spaces, or special characters allowed.  If the
program name already exists, you will be told that the program already
exists and asked whether or not to overwrite it.

Note:  Because the structure of  smart cards vary from type to type,
Brown & Sharpe only supports the use of official 2 meg RefleX
Smart Cards. To purchase additional storage cards, contact your
local sales person. See Appendix 4 for the part number.

Note: Because the size of a program varies, depending on number of
blocks, tolerance information, and screens marked, there is no fixed
number of programs that will fit on a card.  On average a smart card
will hold about 50 non-DCC programs.

Note: To backup your programs obtain storage cards from your Brown &
Sharpe distributor. Save a copy of your program to your regular card.
Insert the backup card into the system and repeat the save process.
RefleX storage cards cannot be read or backed up on a PC.

Save Program
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The Tools Menu - Playback Utilities

Recall Program
The Recall Program softkey lets you recall a program stored on the storage
card.

Important - A recalled program will overwrite any inspection sequence on
the system. Use the Store Program softkey to save an existing sequence
before recalling a new program.

To recall a program from a storage card:

1. Verify that the storage card is inserted.  (If you have only one machine,
this card should always be inserted. If you have multiple machines,
storage cards are sometimes interchanged to transfer programs from
one system to another.)

2. From the Tools menu, select Playback Utilities, followed by Recall
Program.  Select the desired program using the up and down arrows.
Press the Done softkey.

Delete Program
The Delete Program softkey lets you delete a program from the storage card.

To delete a program from the storage card:

1. Verify that the storage card is inserted.  (If you have only one machine,
this card should always be inserted. If you have multiple machines,
storage cards are sometimes interchanged to transfer programs from
one system to another.)

2. From the Tools menu, select Playback Utilities, followed by Delete
Program.  Select the desired program using the up and down arrows.
Press the Done softkey.

Recall Program

Delete Program

Note: When a program is deleted from the storage card, the %full graph will
not change immediately, due to hardware implementations.  When the
card is about 90% filled, the system performs a storage reclamation
process. The previously deleted programs are realized and an increase in
space is shown.
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List Programs
The List Programs softkey lets you list all programs saved on a storage card.
To display a program listing:

1. Verify that the storage card is inserted.  (If you have only one machine,
this card should always be inserted. If you have multiple machines,
storage cards are sometimes interchanged to transfer programs from
one system to another.)

2. From the Tools Menu, select Playback Utilities, followed by List
Programs. Use the Print softkey to print out a listing.

Format card
This password-protected "Format Card" softkey lets you format a standard
Brown & Sharpe storage card.   Although the storage card that comes with the
machine has been formatted at the factory, all subsequently purchased storage
cards must be formatted before they can be used.

Important  - When a card is formatted, all programs will be destroyed!!!

To format a data card:

1. Verify that the storage card is inserted.  (If you have only one machine,
this card should always be inserted. If you have multiple machines,
storage cards are sometimes interchanged to transfer programs from
one system to another.)

2. From the Tools Menu, select Playback Utilities, followed by Format
Card. The system will ask for a confirmation for the format operation.
Press Done to format the card.

3.  While formatting, do not remove the card from the card slot.

List Programs

Format Card
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The Tools Menu - Edit Sequence

Edit Sequence
The edit sequence menu allows you to delete, move, and replace blocks in your
seqence.  This menu only becomes available after 2 or more blocks have been
measured.

Delete Any Measured Block
This softkey allows you to delete any measured block in the sequence.  For
simply removing the last measured block, using the main menu's delete last
block softkey is faster.

Move Last Measured Block
This softkey allows you to move the last measured block above a selected
block.

Move Any Measured Block
This softkey allows you to move any selected measured block above another
selected block.

Important: Do not attempt to move or replace blocks across datum or
probe  blocks.  The datum and probe aspects of the moved
block are not recalculated after movement.

Replace Any Measured Block
Although you can do a "Delete Any Measured Block" and then a "Move Last
Measured Block" to achieve the same results, using this "Replace Any Mea-
sured Block" softkey is faster.

Edit Sequence Menu

Delete Any Block

Move Block

Replace Block

The edit sequence menu is disabled until at least 2 blocks are measured and
after 200 blocks are measured.
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Print Headers:
The Print Headers softkey lets you print identifying headers at any point in the
measuring sequence. If enabled, this printout process will only happen when a
playback program is executed, or when this softkey is pressed.

Enabling Headers:
Enter screen 3 of the system options. Enable the desired headers by either
selecting the 'blank' option, which must be filled in with pen or pencil later, or
by keying in a valid entry. Below are examples of possible headers:

Company: ACME Parts Inc._________________
Name: John Smith________________________
Part Name: DemoBlk1_____________________
Date: 1/1/98_____________________________
Time: 12:53 PM__________________________
Note:  Measured By RefleX_________________

Reference Features:
The Select Reference Feature softkey lets you select a previously measured
feature to be used in all future relationship calculations.

Selecting a Reference Feature:
1. Press the Select Reference Feature softkey from the Tools Menu.
The Select Reference Feature screen is displayed.

2. Use the arrow softkeys to move the highlight over the feature to
be used as the reference feature. Press the Select softkey and then
the Done softkey. To deselect a feature, press the Select softkey
while the highlight is over a selected feature.

D

1
2
3
4

Select

Select Reference
Feature

Printing Headers

The Tools Menu - Misc. Utilities

Note:  Older control-
lers from before Oct.
1999 do not have the
hardware to keep
track of time and
date.  In this case, the
time and date have to
be keyed in.
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Service Utilities:
The Service Utilities softkey is used to diagnose or repair the system. This
password protected area is the same area available at the Home screen. Do not
enter this area unless instructed by a qualified service person.

Moving A Machine and Porting Features:
The “Move Machine” and “Port Features” softkeys are used only with  arm and
horizontal machines.  This functionality is often called “Leap Frog” by other
software packages.  To users of all other types of machines, these functions will
not be available, as they do not apply.  These two softkeys allow a user to
measure one side of a part, move the machine, reestablish the previous datum,
and continue measuring.  In this way, the Arm and Horizontal users are now
able to measure larger parts.

The Tools Menu - Misc. Utilities

Move Machine

Port Features

Move Machine:
The "Move Machine" softkey is used for the first part of the of the leap frog
process.  The user will then move the machine to the it's new location, and
press done.

Port features:
After remeasuring his original alignment, the user will then press the "Port
Features" softkey.  After which, relationships between features measured in the
two machine positions will be able compatible.

Service Utilities

Create Work Instruction / Feature Labeling:
This softkey is used to either instruct an operator during playback, or to
customize a printout.  Use the standard "Playback Pause", "Mark for Printing",
or "Mark for Serial" softkeys to choose.Create Work

Instruction / Feature
Labeling
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The Dial Indicator Mode is used to check straightness or flatness. When the
Dial Indicator Mode is selected from the System Modes screen, the following
screen is displayed:

Important: In the System Modes screen,
the Dial Indicator softkey will remained
dimmed until a hard probe is qualified. A
touch trigger probe will not work in this
mode!

Note: Unlike a conventional dial indicator,
the Dial Indicator mode's "Recall Datum"
feature lets you check the surface of a
feature, regardless of its orientation. Before
using the "Recall Datum" feature, the Dial
Indicator mode alignment is set to the
"machine" alignment, regardless of status
of other measuring modes.

Dial Indicator Mode

Select Axis:  Lets you select the desired axis for measurement.

Zero X, Y, Z Axis: Lets you zero the current selected axis at the current probe
location.

Recall Datum:  Lets you recall a datum that was previously saved in the
Measurements Mode.

Tolerances: Displays the tolerance input screen for setting the upper and lower
tolerance alarms. Use the Down Arrow key to move the highlight from the
Upper to the Lower Tolerance and back. Use the +1 and -1 softkeys to change
the tolerance values.  Press and hold these keys to change in greater increments.

Print:  Depending on the settings in the system options, this softkey allows you
to print or send serial data out the serial port.

Scale Up: Lets you increase the scale of the dial indicator by a factor of 10
(10,100 and 1000 microns).

Scale Down: Lets you decrease the scale of the dial indicator by a factor of 10
(10,100 and 1000 microns).

0: Z

Dial Indicator Screen

Z
Y

X?
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7-4 Scribe Mode
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XYZ Counter/Scribe Mode

XYZ Counter Mode
The XYZ Counter mode, available on non-horizontal machines only, is the
simplest mode in the system.  It shows the machine's counters and lets you zero
each axis individually, or all 3 axes at once.  The machine alignment is always
active in this mode, regardless of datum manipulations in other measuring
modes.

Important: In the System Modes screen, the XYZ Counters Mode softkey
will remained dimmed until a hard probe is qualified.  A touch trigger probe
will not work in this mode!  If this mode is not visible, it is because it has
been disabled in the System Options, or the "Machine Type" option is set to
a horizontal machine.

XYZ Counters
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XYZ Counter/Scribe Mode

Scribe Mode
The Scribe Mode, available only on horizontal machines, displays the scribe
tip location in machine coordinates.  No datum functions are available in this
mode.  The part must be physically aligned to the machine.  The following
softkeys are available in the Scribe Mode:

Absolute:
The Absolute softkey lets you set an absolute zero point in any or all axes.
The absolute zero point may be reestablished after an incremental zero has
been set.

Incremental:
The Incremental softkey lets you set a secondary, local, zero point in any or
all axes.

Note:  The normal number of decimal places shown, determined by the
"Trailing Places" system option, does not apply in the scribe mode.
When the system is set to mm, the scribe mode will display 2 decimal
places.  When the system is set to Inches, the scribe mode will display 3
decimal places.

Absolute Mode

Scribe Mode

Incremental Mode
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Height Gauge Mode

The Height Gauge Mode lets you measure point to point distances, slot
widths, wall thickness, bore center to bore center distances, and bore
diameters.

Height Gauge Measurements
In this mode you must take measurement points along one axis (X, Y, or Z).
Select the axis and take points along that axis.  In the example shown, the Z
axis is selected.

Point to Point
The first measurement point (1) gives the
distance (Z1) from Datum A. The second
point (2) gives the distance (Z2) and also
the distance (DZ1-2) between points 1 and 2.

Slots or Walls
To measure a slot width or wall width, take
one measurement on each side of the slot or
wall.

Two measurement points at slot (1) give the
distance of the midpoint (Z1) from Datum A
and the width of the slot (DZ1).
Two measurement points at slot (2) give the
distance of the midpoint (Z2) from Datum A
and the width of the slot (DZ2).
The distance between the slots (DZ1-2) is
also calculated.

Bore Locations and Diameters
When you measure bores, the system computes
the diameter and location of the bore's center
along the measurement axis.  You can get
center distance measurements by measuring
various bores.

Height Gauge Mode
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1. Select the Height Gauge Mode softkey from the "Startup Options" screen.

2. From the "Select Measurement Axis" screen, select the measurement axis
you will use by pressing the "X Axis", "Y Axis" or "Z Axis" softkey.

     IMPORTANT:  Once you have selected an axis, the system computes
locations and distances only along that axis.  You may only measure in
that axis.

3. Depending on the axis selected, the corresponding screen is displayed.
This screen has a "Recall Probe Tip" softkey to recall a previously quali
fied probe tip, a "Recall Datum" softkey to recall a previously saved datum
and a "Select Axis" softkey to change the measurement axis.  When you
change the measurement axis, all previous measurements are deleted.

4. When you start taking measurements, the system displays the "Taking
Points" screen. You can measure a single point, a slot or wall or a bore.

Measuring a Single Point:

Hard Probe Move the probe along the selected axis and hold the probe
against the surface. Press the Scan button once and then the
Done button.

TTP Move the probe along the selected axis until the probe
deflects. Press the Done button.

Height Gauge Mode

Recall Datum

Recall Probe Tip

Z
Y

X?
Select Axis

Measuring in the Height Gauge Mode
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Measuring in the Height Gauge Mode

IMPORTANT: You can measure a bore in the Top, Side or Front planes
regardless of the measurement axis selected. The system will automati-
cally determine the orientation of the bore.

Measuring a Slot or Wall (2 points):

Hard Probe Move the probe along the selected axis and hold the probe
against the first surface. Press the Scan button once. Move
the probe against the second surface. Press the Scan button
once and then the Done button. Be sure to take only one
point on each side. If you take more than one point, the
system will think its a bore.

     TTP Move the probe along the selected axis to the first point until
the probe deflects. Move to the second point and deflect the
probe. Press the Done button after taking two points.

Measuring a Bore:

Hard Probe Move the probe along the selected axis and hold the probe
against the bore. Press and hold the Scan button while
scanning the complete bore diameter. Press Done.

TTP Move the probe along the selected axis to the bore until the
probe deflects. Take at least 3 measurement points. Press
Done.
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0: Z

Z
Y

X?
Z: 124.548

Measurement 
Along Z

 59.169Z

mm

1
x

 36.478Y

-74.741X

 12.016

 -22.691

As you take measurements, the results are displayed for the last two features
and the 1D distance between them. The Results screen for two slots or walls
appears as shown:

The system will track the last two measured features and the distance between
them. The results are displayed as shown above.

IMPORTANT: The system always shows the results of the last two
measurements. When you measure a new feature it displaces a previously
measured feature. If you press the Select Measurement Axis key, the
screen will clear and you are ready to measure features in the new
selected axis.

Height Gauge Mode Results Screen

Result area for
distance between
last two
measurements

Current
measurement
axis

Result area for last
measurement

Result area for
previous
measurement

Recall a Probe Tip

Select Measurement Axis

Zero Selected Axis

Set Nominals and Tolerances

Print Results

Probe Tip and datum

Recall a Datum
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Height Gauge Mode Results Screen

Following are the Measurement Types and Result descriptions:

Type Symbol Measured Description
Axis

X Location of a point along the measurement
Y axis.
Z

X Distance between two points along the
Y measurement axis.
Z

XYPL Major and minor location of the bore
(Top) center and the bore diameter.  The major
YZPL and minor axes are determined by the
(Side) bore reference plane:
ZXPL
(Front/ Reference Plane Major Minor
Back) XYPL X Y

YZPL Y Z
ZXPL Z X

XYPL Distance between two bores along the
YZPL the bores' major and minor axes.
ZXPL Note: If the bores were measured in

different planes, no relationship is
computed.

X Distance between a point and a bore
Y center.
Z Note: The distance is computed only if the

reference plane of the bore contains the
measurement axis of the point.
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Height Gauge Mode Results Screen

Following are the Measurement Types and Result descriptions:

Type Symbol Measured Description
Axis

X Location of the midpoint of two measure-
Y ments and the distance between the two
Z along the measurement axis.

X Distance between two midpoints along the
Y measurement axis.
Z

X Distance between a midpoint and the
Y center of a bore along the measurement
Z axis.

Note: The distance is computed only if the
reference plane of the bore contains the
measurement axis of the midpoint.

X Distance between a point and a midpoint
Y along the measurement axis.
Z
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Height Gauge Mode Softkeys

The Height Gauge Mode softkeys:

The "Recall Probe Tip" softkey lets you recall a previously qualified tip.  To
qualify a probe,  use the "Probes" softkey in the "Startup Options" screen.

The "Recall Datum" softkey lets you recall a previously saved datum created
via the measurement mode.

The "Select Axis" softkey lets you choose the desired measurement axis.

The "Zero Axis" softkeys zero the current measurement axis at the location of
the current measured feature. The softkey displayed depends on the measure-
ment axis.  For slots and walls the zero is set at the center of the slot or wall.
For bores the zero is set at the center of the bore.

The "Print" softkey prints the results of Height Gage Measurements.

The "Tolerance" softkey displays the tolerance window.  In this screen, you can
set tolerances of measured features as well as setting the printer output format.
See the next page for descriptions of softkeys used in the tolerance screen.

Recall Probe Tip

Recall Datum

Z
Y

X?
Select Axis

Zero Axis

Print

Tolerance

0: X 0: Y 0: Z
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Height Gauge Mode Tolerance Softkeys

The Height Gage Mode's tolerance screen softkeys:

The "Abort" softkey discards changes made in the tolerance window and
returns you to the Height Gauge Measurement screen.

The "Scroll Down" softkey advances the highlight to the next item (Output,
Nominal, Upper Tolerance, Lower Tolerance) in the tolerance window.

The "Cycle Option" softkey cycles through the following "Output" choices:

Measured: The system prints only the measured value.
Full: The system prints the measured value, nominal value, upper

tolerance, lower tolerance, deviation and out-of-tolerance
graph.

Tol Band: Prints only the tolerance graph showing measured value
location in the tolerance zone or out-of-tolerance deviation.

Out-Of-Tol: Same as Full Format except it is only printed when the
selected feature is out of tolerance.

None: Does not print the highlighted value. Use this option to print
only the items desired. When None is selected, the value
will not show on the screen or the printout.

The "ISO Tolerance" softkey is only available when entering tolerance
information for diameters. The system displays an ISO Tolerance Table based
on the nominal diameter and whether the measurement is internal or external
(bore or pin).

The "Keyin Value" softkey is used for entering nominal or tolerance values.
When this key is pressed, you can change the value of the highlighted item
using  the "+1", "-1", and "+/-" softkeys.   After the value has been keyed-in,
press the Done softkey to return to the tolerance window.

The "Next result" softkey advances the highlight to the next result window.
The nominal, tolerance, and output type must be specified for each window.

When the "Done" softkey is selected, all changes are accepted and you are
brought back to the Height Gage mode's measurement screen.

Scroll Down

Abort

Change Option

ISO Tolerance

0.0 05
+

Keyin Value

Next Result

Done
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The Digitize Mode is used to send point data through a null modem serial
cable to a waiting host computer.   When the Digitize Mode softkey is selected
from the "System Modes" screen, the following screen and options appear:

XYZ Output: This option determines if points will be output in
"Absolute" coordinates or "Incremental" coordinates.
Absolute coordinates are references from the current
active datum.  Incremental coordinates are referenced
from the previous measured point.

Points/Sec: When using a hard probe, this option controls the
number of points taken during the scanning of a part.
Allowable values are 1-10 points per second and
continuous.

Min. Distance: This option specifies the minimum distance the probe
must travel before the next point is digitized. The
smallest allowable distance is 0.000 mm.  This is always
a positive value.

Part Drawing: This option controls the part drawing display in the
upper left corner.  You can be view the points from the
top (XY plane), front (YZ plane) or side (ZX plane).
This option has no affect on the data being sent.

The Digitize Mode

X:    2 .123
Y:   0 .392
Z:    9.938

Digitize

AbsoluteXYZ Output
Points/Sec 10

0.040
XY Plane

Min. Distance
Part Drawing

1 1

Y

X

mmDigitize Mode Softkey

Important:  The data sent via the Digitize mode is tip center data only, and
is not probe tip compensated!

Note:  For information on how to send data to Windows 95, 98, or NT's
Hyperterminal program or the optional RefleX Scan package, see
appendices A5 and A6 respectively.

Note:  As soon as the user begins taking points or scanning, data is
automatically being sent out the serial port.  It is because of this that
using this mode is ideal for setting up serial communications.
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The Digitize Mode

!SOT
!inch
!abs
X 1.18085 Y 1.89919 Z-11.77133
X 4.72437 Y 1.35143 Z-11.77121
X 3.73981 Y 5.41855 Z-11.77128
X 1.18078 Y 4.65511 Z-11.77128
X 2.36207 Y 1.97911 Z-11.77121
X 1.15117 Y 1.90093 Z-11.77149
X 4.69475 Y 1.35325 Z-11.77129
!EOT

The following softkeys are available in the Digitize mode:

The "Recall Probe Tip" softkey allows you to recall a previously qualified
tip.  To qualify a probe, use the "Probes" softkey in the "Startup Options"
screen.

The "Recall Datum" softkey allows you to recall a previously saved datum
created via the Measurement mode.

The "Scroll up" softkey allows you to scroll upwards through the options
listed on the previous page.

The "Scroll down" softkey allows you to scroll downwards through the
options listed on the previous page.

The "Change Option" softkey cycles through the available choices for the
highlighted option.

The "Keyin Value" softkey is used to enter values for a selected option.
When this key is pressed, you can change the value of the highlighted item
using  the "+1", "-1", and "+/-" softkeys.   After the value has been keyed-
in, press the Done softkey to return to the Digitize mode screen.

When the "Done" softkey is pressed, all changes are accepted and you are
brought back to the Digitize screen.

The following is an example of the Digitize mode's serial output:

0.0 05
+

Change Option

Done

Keyin Value

Recall Datum

Recall Probe

Scroll Up

Scroll Down
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Passthrough Mode

Passthrough Mode Overview:
Passthrough mode is used to send data

from RefleX to a PC software package such as
PC-DMIS or Xact Measure.  In a typical
application, a user has many RefleX machines,
yet only 1 laptop running PC-DMIS.  For
these jobs which require CAD functionality,
an operator can simply bring the laptop to the
RefleX station, plug in the null modem serial
cable, and begin using PC-DMIS as usual.

 

Machine 

 RefleX 

PC-DMIS

Serial 
Cable 

Encoder 
cables, etc. 

Setting up PC-DMIS:
Before using PC-DMIS, the RefleX interface

must be installed and enabled in the dongle.
After that is done, simply start PC-DMIS.

Setting up RefleX:
In page 4 of the system options (see section 10-16), make sure that the serial

settings are set up for 9600, 8, none, 1.  This is the default for PC-DMIS's
interface driver.  Later, if you are having trouble communicating, make sure that
these values are set correctly in PC-DMIS.

In the "System Modes" screen press the "Pass-Through" softkey.  If the
softkey is not visible, enable it in the system options.  See section 10-18 for
more information about enabling passthrough mode.

After the "Verify PC is Ready" is shown, press the "Done" softkey.  The
volcomp file in the RefleX controller will then be downloaded to the PC.
Because of this methodology, the operator never has to worry about manually
switching volcomp files in the PC.   At this point, you will notice a "Volcomp File
Being Recieved" in PC-DMIS.
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Using Passthrough Mode:
After the volcomp file has been sent, it is no longer necessary to look at

the RefleX Controller.  PC-DMIS can be used as usual, including Z-Mouse
functionality.  The operator can, however, use RefleX's "Abort Scan", "Clear
Last Hit", and "Done Scan" softkeys if desired.  A "Points Taken" display is
also shown.

Passthrough Mode

Exiting Passthrough Mode:
To exit passthrough Mode, simply press the system startup button

located on the middle left of the RefleX controller.

Abort Scan

Clear Last Hit

Scan Done

The System Startup
Button
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10-5 Language Screen, Speaker Volume, Units
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System Options

Introduction to System Options
System Options are used for setting such items as the machine type, the
controller's screen contrast, and the qualification sphere's diameter. Because
there are too many options to fit in a single screen, 5 screens are used. Shown
below is the first screen of System Options, known as "Page 1" of the System
Options.

Note:  Because all system options are saved in the controller's memory, the
system will remember these saved values next time the controller is started.

Important:  Never reinsert a previous version software card unless abso-
lutely necessary.  Because the structures that hold the options will most
likely be different, doing so will result in a loss of your saved options.

Scroll Down

Next Option Screen

Change option

Done

Abort

Scroll Up
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System Options

Language & Machine Type

Language

Default:  English

Values: English, German, Italian,
French, Spanish, Portuguese, Swedish,
Finnish, Polish, Dutch, Danish, Czech,
Simplified Chinese, Traditional
Chinese, Japanese & Korean.

Description:  The Language  option
sets the language of the system.  The
startup sequence's language screen
alsoallows language selection. By
placing this option here, the language
can be set without rebooting the
controller.

Machine Type

Default:  Gage2000

Values: Bridge type machine (Based on Volcomp file type):  Gage2000,
Derby, uXcel 765/r, uXcel 7105/r, RefleX 343, RefleX 454, or other.
Horizontal type machine (Based on Volcomp file type): Gage2000H, or
Derby II.
TTL type machine (Based on Controller type):  Mistral 775, Mistral
1077, Mistral 7105, or Other.
Heidenhain  Machine (Based on Controller type):  Other.
DCC Machines (Based on serial query): Microval PFX 454
Arm Machines (Based on serial query): Gage2000 A

Description:  This option tells the system which machine is being used.
When set to "Other", a "Other Machine" softkey appears which allows a
user, after entering the password, to enter axis lengths, axis direction,
pitch, etc.  This machine type is used for upgrades purposes.

Troubleshooting:  If you Measurement Mode's part drawing isn't
scaling correctly, or the flying probe isn't visible,  it can only be caused
by two things:
1. The machine was not homed correctly, or
2. The "Machine Type" option is set incorrectly.

System Options Page 1

Other Machine
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System Options

Language Screen, Speaker Volume& Units

Language Screen

Default:  On

Values: On, Off

Description:  This option allows you to turn the startup sequence's
language screen on or off.

Tip:  If you are working in a uni-lingual shop, turn the "Language
Screen" option off to facilitate system startup.

Speaker Volume

Default:  10

Values: 0, 1, 2, 3, 4, 5, 6, 7, 8, 9, 10.

Description:  The volume of the system's speaker can be set with a value
from 0 to 10.  At a value of 0 the speaker is off.

Note:  If you have a controller from before October, 1999, this option is
not available.  Older controllers have a "Sound" option which is either
"Enabled" or "Disabled.  Also note that some of these controllers were much
quieter.

Note:  On Arm machines, there is also a "Arm Beep Volume" option which
controls the volume of the arm's internal speaker.

Units

Default:  mm

Values: Inches or mm.

Description:  This option lets you set the system's measurement units to
either metric millimeters or English Inches.

Tip:  Notice how switching between mm and Inches changes the "Trailing
Places" option located below the "Units" option.
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System Options

Trailing  Places, Angles, Delimiter, Startup Probe
Trailing Places

Default:  3 for millimeters or 5 for Inches

Values: MM: 2, 3.  Inches: 4, 5.

Description:  This option lets you set the number of decimal places
shown.  For example, if the system's "Units" option was set to "mm" and
the "Trailing Places" option was set to 3, a typical value would be
displayed as "12345.678".  See the "Units" option above.

Angles

Default:  Decimal

Values: Decimal or DD:MM:SS

Description:  This option lets you set an angle display. An angle
displayed in "Decimal" format will look like "45.008". An angle
displayed in "DD:MM:SS" will look like "045:00:27"

Tip:  Remember, for an angle, the decimal value "45.510" is very
different than "45:51:00".

Delimiter

Default:  Period

Values: Period, Comma

Description: This option lets you set the symbol to represent the deci-
mal point.  You can choose either a period (123.456)  or a comma  (123,456).

Startup Probe

Default:  Qualify

Values: Qualify, Saved

Description: This option specifies whether the system requires you to
qualify a probe on startup, or allows you to use a previously saved
probe.  This option has the same effect as the "Save Startup Probe"
found in the Probe menu.
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System Options

Air Saver &  Contrast

Air Saver

Default:  0 (Off)

Values: 0-999 minutes

Description: The Air Saver timeout sets the number of minutes the
system will wait before turning off the air via the optional Air Saver.  A
value of 0 disables the Air Saver.  This option is not shown for Arm or DCC
machines.

Tip:  For non-arm and non-DCC machines, the air filters are supposed to
remove all of the oil from the air.  But, some customers with extremely high
concentrations of oil still have problems.  By turning off the air when the
machine is not in use, the air saver can provide a very inexpensive fix to a
potentially serious problem.

Contrast

Default:  Factory set to optimum contrast

Values: 0-25

Description:  This option lets you set the contrast of the controller's screen.

Note:   The screen's contrast will change with temperature and location of
the operator.

Note:   Changing the contrast and setting the system's volume are the only
options that can be set with the controller without having a software card
inserted.  The reason for this is so that if you set the contrast to a value in
which the screen can not be viewed and then turn off the controller, there is
no way for you to navigate the menus to get back to the system options to
reset the contrast.  Use the top and bottom right buttons to set the contrast.
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System Options

Points / Sec. & Minimum Distance

Points / Sec.

Default:  10

Values: 1,2,3,4,5,6,7,8,9,10

Description: This option sets the
number of points takenper second
when scanning with a hard probe.

Troubleshooting:  If Counters update
slowly, it is because the "Points/Sec."
option is set to a value lower than 10.

Min. Distance

Default:  0.040 mm.

Values: 0.000 mm. and up

Description: "Min. Distance" is the "Minimum Distance between
points".  This feature, especially important during hard probe scanning,
prevents multiple points being taken when the machine has briefly
stopped moving.

Troubleshooting:  If while scanning, the system is taking points
sporadically, or taking 1 and only 1 point, it is because the "Min.
Distance" option is set to a high value.
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System Options

Nearest Nom., Ref. Length, Min. Cyl. Depth

Nearest Nom.

Default:  0.100 mm.

Values: Any positive value greater than 0.000.

Description:  This option (Nearest Nominal) defines how the system will
calculate the nominal, based on the measured value.

0 Truncates the measured value
1 Rounds the value to nearest whole value
other Approximates to nearest fractional value.

Example:  For a measured value of 50.083 mm, the system will calculate a
nearest nominal of 50.100 mm, when this option is set to 0.100.

Ref. Length

Default:  Computed

Values: Computed, User Defined

Description: This option (Reference Length), is used to compute
squareness, parallelism, and angularity.  The value can be either based on
the points measured, or you can key in a value.

Min. Cyl. Depth

Default:  7.000 mm

Values: 1.000 mm and up

Description: This option (Minimum Cylinder Depth) helps the system
distinguish between circles and cylinders.  If you do not lock the appropri-
ate axis when measuring a circle, it may look like a cylinder to the
system.  Also, when you measure very small bores, they may look like
circles to the system.  This option helps distinguish between the two.

Tip:  Even if your cylinder is solved as a circle, or vise-versa, you can
always force the solved feature to the desired feature.  See Chapter 5 for
more information.
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System Options

Qual Sphere Diameter, Squareness Limit, Cone Angle

Qual Sphere Dia

Default:  19.050 mm

Values: All positive values

Description: The Qualification Sphere Diameter is the diameter of the
qualification, or reference, sphere. This diameter is often stamped on
the side of the sphere's support arm.

Troubleshooting:  If this option is set incorrectly, the "Qualification
Results" screen will consistently show high or low probe diameters.

Squareness Limit

Default:  5.000 degrees or 005:00:00 degrees

Values: All positive values.

Description:  This option helps the system distinguish between parallel
or square features and oblique features.

Example:  If the Squareness Limit was set to 5 degrees, two cylinders
with an included angle of 2 degrees would be considered parallel. If that
squareness limit were set to 1 degree, they would be considered oblique.

Troubleshooting:  If you cannot see intersection screens, such as the
"intersection between two lines" screen, it is because you did not lock an
axis and the two lines don't intersect.  The other possibility is that the
squareness limit is set to an invalid value.  An appropriate value for the
squareness limit option is 5.000 mm.

Cone Angle

Default:  Half

Values: Half, Full

Description:  This option is used to select the display of a cone's angle.
The half angle represents the angle between the cone's axis and its
surface.  The full angle represents the included angle of the cone.
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System Options

Perpendicular Angles, Send to Printer

Perp. Angle

Default:  Actual

Values: Actual, Gauge

Description:  This option is used in the display of perpendicular angles.
When "Actual" is selected, an angle of 89.997 will be displayed as 89.997
degrees. When "Gauge" is selected, the deviation between 90 degrees and
the angle is shown. In this case the gauge angle would be 0.003 degrees.

Send to Printer

Default:  Disabled

Values: Disabled, Epson LX300 (U.S. &
China), Epson LQ570+ (U.S.), Okidata 320
(U.S.), Panisonic 2135 (Europe), Epson VP-
600 (Japan), Epson LQ-570HD (Korea)

Description:  When a valid printer, has
been chosen, the "Print" softkey will
appear in the "Measurements", "Height
Gage", and "XYZ Counters" modes. Note:
The printer will not be visible in the
Measurement Mode until a valid feature
has been measured.

Note: The printers listed above are the only printers supported by Brown &
Sharpe.

Troubleshooting:  Most printing problems are a direct result of using
unsupported printers.  Before contacting your local service person, verify
that you are using a supported printer.

Tip:  Although the system may not be able to print to your favorite printer
directly, there is another way.  Use the serial output capabilities to transfer
your measurement results to a serial capture utility such as Window's
Hyperterminal program.  Then print from there.  Some customers even take
it one step further and create a Microsoft WordTM  template complete with
logos, digital pictures, and work instructions.  Using this procedure, you
can create reports that are only limited by your imagination.

Print
Playback Stop
Send to Stats

Serial Out

Print
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System Options

Send out Serial

Send out Serial

Default:  Disabled

Values: Disabled, DataPage, Gage Talker, Mitutoyo, Generic,
Print Format

Description:  This option sets the serial output format. Toleranced circle
data, shown below, is sent out in the 5 formats.  Because the system uses
the serial port to communicate with the machine's controller, on a dcc
system, serial output is disabled.

DataPage:
!SOT
DEFAULT  CIX1    X  75.076   75.100   0.100   -0.100
DEFAULT  CIY1    Y  87.272   87.300   0.100   -0.100
DEFAULT  CIID1   D  53.083   53.100   0.100   -0.100
!EOT

Gage Talker:
DEFAULT ,1, X, CI, 75.076,75.100,0.100,-0.100,-0.024
DEFAULT ,1, Y, CI, 87.272,87.300,0.100,-0.100,-0.028
DEFAULT ,1,ID, CI, 53.083,53.100,0.100,-0.100,-0.017

Mitutoyo:
01A 53.082737

Generic:
DEFAULT ,1, X, CI, 75.076,75.100,0.100,-0.100,-0.024
DEFAULT ,1, Y, CI, 87.272,87.300,0.100,-0.100,-0.028
DEFAULT ,1,ID, CI, 53.083,53.100,0.100,-0.100,-0.017

Serial Out

Print
Playback Stop
Send to Stats

Serial Out

       Print Format:
==> Circle (1)
..: Circle

  MEASURED  NOMINAL  UPPER TOL LOWER TOL DEVIATION OUT/TOL
X 75.076 75.100 0.100 -0.100 -0.024 ==*====
Y 87.272 87.300 0.100 -0.100 -0.028 ==*====
Diameter 53.083 53.100 0.100 -0.100 -0.017 ==*====

Note: For more information about the different Print formats, see section
5-15
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System Options

Playback Pause, Print Company, Print Operator

Playback Pause

Default:  Disabled

Values: Disabled, Enabled

Description:  This option lets you stop and view the results of a measure-
ment before continuing with the playback process.

Print Company

Default:  Disabled

Values: Disabled, (blank), Company1

Description:  This option lets you enter
the company's name into the system. The
"Enter Text" softkey brings up a keyboard
to enter text. Later, when the "Print
Headers" softkey is pressed (See Chapter 5)
or a program is recalled, the following will
be sent to the printer:

Company: ACME Parts Inc.

Print Operator

Default:  (blank)

Values: (blank), Name1, Name2, Name3, Name4, Name5, Disabled

Description:  This option lets you enter your name into the system. The
"Enter Text" softkey brings up a keyboard to enter text. Later, when the
"Print Headers" softkey is pressed (See Chapter 5) or a program is recalled,
the following will be sent to the printer:

Name: John Smith

Playback Pause

Print
PlaybackPause
Send to Stats

Serial Out

Enter Text

Enter Text
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System Options

Print Part Name, Print Date, Print Time

Print Part Name

Default:  (blank)

Values: (blank), Actual, Disabled, Part1

Description:  This option, set to Actual, prints out the saved program
name at the top of the printout.  It can also be used to key in a different,
user defined part name.

Part Name: DemoBlk1

Print Date

Default:  Disabled

Values: (blank), Actual, Disabled

Description:  This option, set to Actual, displays the date at the top of a
printout. When the "Print Headers" softkey is pressed (See Chapter 5) or
a program is recalled, the following will be sent to the printer:

Date: 1/1/98

Note:  Regardless of software version, older controllers are unable to
remember time and date.  Newer controllers, however, have a Y2K (Year
2000 Compliant) clock, similar to ones found in a computer.

Print Time

Default:  Disabled

Values: (blank), Actual, Disabled

Description:  This option, set to Actual, displays the time at the top of a
printout. When the "Print Headers" softkey is pressed (SeeChapter 5) or
a program is recalled, the following will be sent to the printer:

Time: 12:53 PM

Enter Text

Enter Time

Enter Date
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System Options

Print Note, Require Points
Print Note

Default:  Disabled

Values: Disabled, (blank), Actual

Description:  This option lets you print a comment at the top of a printout.
The "Enter Text" softkey brings up a keyboard to enter text..  When the
"Print Headers" softkey is pressed (See Chapter 5) or a program is recalled,
the following will be sent to the printer:

Note:  Measured By RefleX

Tip:  Use the "Print Headers" feature as often as possible to reduce confu-
sion when dealing with many parts and printouts.

Require Points

Default:  Disabled

Values:  Disabled, Enabled

Description:  This option, when enabled required the operator to take as
many points in playback, as was learned in the original inspection.  So, for
example, if a you take 13 points to measure a circle, in playback, the done
button will not appear until you've taken 13 points.

Note:  This option should be enabled for DCC playback.

Enter Text
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System Options

Mouse, Printer Format, Baud Rate, Word Length, Parity

Mouse

Default:  ZMouse
Values: ZMouse, Desk Mouse, Scan/
Done, None.
Description:  This option lets you switch
between a ZMouse, Desk Mouse, and
Scan Done assembly.

Troubleshooting:  If the cursor only
scrolls up and down through the softkeys
when you move the ZMouse left to right,
then you have a desk mouse selected,
instead of a  ZMouse.

Tip:  When using an optical probe, use a desk mouse, or serial mouse,
instead of a ZMouse. The ZMouse is difficult to access when the optical
probe is installed. Using a desk mouse will reduce Z-rail movement.

Printer Format

Default:  Text
Values: Text, Graphic, Both
Description:  This option lets you chose the type of printout.  A Graphic
printout displays exactly what is shown in the results section of the
Measurement Mode's screen.  The Text printout sends text only to the
printer.  See the "Print Format" serial output format type in Chapter 5 for an
example.

Baud Rate

Default:  9600
Values:  1200, 2400, 4800, 9600, 19200, 38400, 57600, 115200
Description:  This option sets the baud rate of the serial port.

Word Length

Default:  8
Values: 7, 8
Description:  This option sets the word length of the serial port.

Parity

Default:  None
Values: None, Even, Odd
Description:  This option sets the parity for the serial port.
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System Options

Stop Bits, Probe Holder, TTP Type, Vorne Display, Dial Indicator

Stop Bits

Default:  1
Values: 1, 2
Description:  This option sets the stop bits for the serial port.

Probe Holder

Default:  Standard
Values:  Standard, Universal
Description:  This option, available
 for the horizontal machines only, is used to switch between the two possible probe
holders.  If the wrong holder is selected, the machine will not compute the correct
offsets during probe qualification.

TTP Type

Default:  TP-ES
Values:  TP-ES, TP-MIP
Description:  This option chooses which TTPprobe is being used.  After setting this
option correctly, the correct probe will be shown in
the qualification screens.

Vorne Display

Default:  Disabled
Values:  Disabled/Enabled
Description:  This option enables or disables the external, optional Vorne XYZ
counter display.    Before using this display, its serial port must be set up.  (Usually
9600 Baud, 8 data bits, 1 stop bit. - See Vorne manual)  RefleX's serial port should
also be set up accordingly (Section 10-16).  Be sure to obtain the correct Vorne serial
cable as it is not a standard "straight through" or "null-modem" cable.  Note:  The
Vorne display will not work in the digitize and
passthrough modes because the serial port is
already being utilized.

Dial Indicator

Default:  Enabled
Values: Enabled, Disabled
Description:  This option enables or disables the
Dial Indicator Mode.  When disabled, the Dial
Indicator Mode softkey no longer appears in the
system modes screen.

Note:  The Dial Indicator mode is only
available when a hard probe is qualified.

Dial Indicator Mode

Universal Standard

TP-ES TP-MIP

Vorne Display
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System Options

XYZ Counter Mode / Height Gage Mode, Digitize Mode, PassThrough
Measurements

XYZ Counter Mode / Scribe Mode
Default:  Enabled
Values: Enabled, Disabled
Description:  If the machine is a horizontal type machine, this option
will enable or disable the Scribe Mode.  If the machine is a bridge type
machine,this option will enable or disable the XYZ Counter Mode.
When disabled, the XYZ Counter or Scribe softkey no longer appears in
the system modes screen.

Height Gauge
Default:  Enabled
Values: Enabled, Disabled
Description:  This option enables or disables the Height Gauge Mode.
When disabled, the Height Gauge softkey no longer appears in the
system modes screen.

Digitize Mode
Default:  Enabled
Values: Enabled, Disabled
Description:  This option enables or disables the Digitize Mode. When
disabled, the Digitize softkey no longer appears in the system modes
screen.  Because there are 6 modes and only 5 slots available to display
the modes, when the digitize mode is enabled, passthrough mode is
automatically disabled.

Pass-Through Mode
Default:  Enabled
Values: Enabled, Disabled
Description:  This option enables or disables the PassThrough Mode.
When disabled, the PassThrough softkey no longer appears in the
system modes screen.   Because there are 6 modes and only 5 slots
available to display the modes, when the passthrough mode is enabled,
digitize mode is automatically disabled.

Measurements Mode
Default:  Enabled
Values: Enabled, Disabled
Description:  This option enables or disables the Measurements Mode.
When disabled, the Measurements softkey no longer appears in the
startup system modes.

Height Gauge Mode

Digitize Mode

Measurements Mode

XYZ Counters /Scribe
Mode

Tip: Turn off the modes you do not use to alleviate startup confusion.

PassThrough Mode
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DCC Playback, Prehit Distance,
Posthit Distance

DCC Playback

Default:  Disable

Values: Enabled, Disabled

Description:  This option turns DCC
playback on or off.  When disabled,
no point information is saved and
playback will run just like a manual
system.  When this option is
enabled, the point information is
saved.

Prehit Distance

Default:  5.000

Values: Any value greater than 0.000

System Options

Note:  This "DCC Options" screen
is only available if the controller is

plugged into a DCC Machine.

Description:  This option tells the system how far before the nominal
measured point to begin searching for the part.  During this "searching"
period, the system's velocity is set to the "pre/posthit speed".  If the system
does not contact the part during the prehit region, it will continue search-
ing through the poshit region.

Posthit Distance

Default:  5.000

Values: Any value greater than 0.000

Description:  This option tells the system how far after the nominal
measured point to continue searching for the part.  During this "searching"
period, the system's velocity is set to the "pre/posthit speed".  If the system
does not contact the part during the posthit region, an error screen will be
displayed.
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Alignments, Clearance Speed, Pre/Posthit Speed, Max Accelearation

Alignments

Default:  Manual

Values: Manual, DCC

Description:  When set to "Manual", playback will prompt the user to
measure the first few features manually until a datum has been estab-
lished.  After that, DCC playback will begin.  When set to "DCC", all
steps will be measured in DCC mode.  This means that subsequent
measured parts must be in the same location as the part which was
learned.  (This is often used in fixture programming)

Clearance Speed

Default:  80%

Values: 10% - 100 %

Description:  This option sets the velocity which the machine will
move when it is not in the prehit / post hit zone.

Pre/Post hit Speed

Default:  20%

Values: 10% - 100 %

Description:  This option sets the velocity which the machine will
move in the prehit / post hit zone.

Max Acceleration

Default:  80%

Values: 10% - 100 %

Description:  This option sets the maximum accelearation which the
controller is allowed to exert on the machine.

System Options
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Frequent Questions/Troubleshooting

Question/Problem

Is the RefleX system year 2000 Compliant?

Which printers does RefleX Support?

My controller is displaying a frown face or skull & crossbones.

My controller locks up

What is a rate error and what can I do about it?

My part drawing isn't scaling correctly.
I can't see the "flying probe"

My controller won't boot up

I'm having accuracy problems

I consistently get an incorrect probe tip diameter.

Why are the Dial Indicator and XYZ Counter Mode softkeys
dimmed?

How can I get more storage cards?

How many programs does a storage card hold?

What is the Air Saver

What is RefleX Scan

I consistently get a "Can Not Solve" error screen during my first
probe qualification.

I can not hear RefleX's speaker

I can not see RefleX's screen

How does RefleX Handle it's volcomp files?

I can not see the "intersection between two lines" screen.

I deleted some programs, but my %filled has not gotten any smaller.

Even with the filters, there is still a lot of oil on my machine.  What
can I do?

My ZMouse only works when I press it left to right instead of up and
down.

Solution

See Chapter 10 Page 14

See Chapter 10 Page 11

See Chapter 11 Page 4

See Chapter 11 Page 4

See Chapter 11 Page 5

See Chapter 10 Page 4

See Chapter 11-4

See Chapter A9-1

See Chapter 10 Page 10

See Chapter 6 Page 3

See Chapter 5 Page 30

See Chapter 5 Page 30

See Chapters 10 Page 7, 2 Page 5

See Chapter  A5 Page 1

See Chapter 2 Page 12

See Chapter 10 Page 5

See Chapter 10 Page 7

See Chapter 11 Page 6

See Chapter 10 Page 10

See Chapter 5  Page 31

See 10 - 7

See Chapter 10 Page 15
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Frequent Questions/Troubleshooting

Frown Face Errors
A frown face error is often a sign that a serious hardware error has occurred
and the controller must be replaced.  There are, however, a few other reasons
for these errors to occur.

1. If the ZMouse cable is plugged into the serial port, a frown face
error will occur. ("5. EC_UART1")  Remove the ZMouse cable from
the serial port and plug into ZMouse port.

2. Any defective PCMCIA software card inserted into the controller
will cause a frown face error.  If this happens, there will be no error
code under the icon.  Replace any suspected card with a known
good card. Be careful not to load a volcomp file from the card and
into the controller when the 'Volcomps do not match' screen
appears.

3. If there is a short in the ZMouse or extension cable, a frown face
error will sometimes appear.  To temporarily alleviate the problem,
remove the ZMouse cable and contact your local Brown & Sharpe
distributor for a new ZMouse and/or extension cable.  This problem
will also show itself by locking up the system at the first system
startup (copyright, language, volcomp, or home) screen, or, by
showing a blank screen on startup.

4. Frown face errors: ("19, 20, 21, 22:  Measuring System Failed") will
be displayed if the RefleX power supply is defective. Contact your
local service representative for instructions on how to diagnose and
fix this problem.  This problem may also show itself by a bright,
unreadable screen with little or no contrast.

Note: In older controllers a "skull & crossbones" icon is used in place of
the "frown face" icon.

Controller lockups:
Controllers with a defective power supply will lock up sporatically.  It is for
this reason, when ever returning a controller, always include the power
supply.   If the controller only locks up at the copyright or language screen,
see #3 above.

Controller won't boot:
If the controller will not boot, unplug all external devices and remove both
cards.  If an alternate power supply is available, use it.  Make sure the power
cord is plugged in securely.  If the box still can not boot to the "Insert Card"
icon  screen, the box is defective and should be returned (with power
supply).

Frown Face Errors
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Frequent Questions/Troubleshooting

Rate Errors

What is a Rate error and how is it caused?:
A Rate error is the electronics way of notifying you that encoder signal quality
is unacceptable.  Because of that, exact machine position may be in error.
There are many variables that can cause Rate errors.  These include:

• This is a brand new controller not yet tuned to your machine.
• An encoder cable is not plugged in securely.
• Dust, dirt, oil, etc. on scales.
• The previous AutoTune was not performed correctly.
• An encoder's performance has degraded.
• An encoder has slipped out of alignment.
• The encoder or scale is defective.
• The encoder cable has a broken wire.
• A hardware error has occurred inside the RefleX controller.

Fixing a Rate Error:
• If this a brand new controller, perform an AutoTune as described in

section A7.
• Check the encoder cables.  Are they all tight? If not, screw them in

tight.
• What is the machine's environment? If there is a lot of dust or oil in

the air, check to see if the scales are clean. If dirty, clean them with a
soft, lint-free cloth and rubbing alcohol.

• Try doing an AutoTune.  If it is still not working, there are now only
two possibilities.  It is either a defective encoder system or a defective
controller.

• To check, take the bad axis (the axis giving you the problem) and swap
the connectors on the back of the controller with a good axis (one not
having problems).  Wait for another rate error to appear by starting a
normal RefleX operation.  Did the rate error switch axes?  If so, then
there is a problem in your encoder system. If not, there is a problem
with the controller.  For either problem, contact your local service
representative.
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Frequent Questions/Troubleshooting

RefleX Volcomp Files
For non-DCC and non-arm systems, the RefleX controller stores it's volcomp
file in two places:  In its internal memory and on the software (upper)
PCMCIA card.  Do not exchange software cards between systems as you may
accidentally load an incorrect volcomp file.  On a DCC system, the volcomp
is stored in the FB-PC and the screens and procedures below do not apply.

When Controller volcomp and Card volcomp do not match.  Case 1:
Software SN:  123456
Controller SN:  None
Default action - System will prompt user to upload from software card to

the controller.
Reasoning - Facilitate Replacement of Controllers. If you are given a new

controller, when you place your old card in the new controller, all
you must do is press Done and your volcomp file will be loaded.

Loading Procedure:
1. Install RefleX controller as shown in manual (cables, mounting, etc.).
2. Remove PCMCIA cards from old RefleX controller (software and

storage).
3. Insert old PCMCIA cards into new RefleX controller.
4. Turn on your new RefleX controller.
5. Wait for language screen to appear. Select a language and then press

the Done button.
6. The volcomp load screen (shown below) appears. Press Done and

your volcomp file is automatically loaded from the old card.

Note: The volcomp number, displayed at the upper left section of the
homing screen, will now match the machine serial number found on the
back of the RefleX machine.
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Frequent Questions/Troubleshooting

RefleX Volcomp Files
When Controller volcomp and Card volcomp do not match.  Case 2:

Software SN:  None          Controller SN:  123456
Default action - System will prompt user to download volcomp file to
software card.
Reasoning -Facilitate RefleX software updates.  After a volcomp has been

loaded into the controller via the doflex.exe program, the next time the
controller is restarted, when the Done button is pressed, a duplicate
copy is created on the software card.

When Controller volcomp and Card volcomp do not match.  Case 3:
Software SN:  123456         Controller SN:  654321

Default action: - System will prompt user to upload volcomp file from
software card to the controller.

Reasoning: - No matter where a RefleX replacement controller comes from
(or what volcomp file it has) you should be able place your old card
(with your good volcomp file on it) into the controller and have it load
automatically.
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Frequent Questions/Troubleshooting

Alternative -If you want to download a volcomp file from the controller to
the software card when volcomp files exist on both, do the following:

1. When above screen is shown, press cancel.
2. At the homing screen, record the number at the top left portion of

the screen.
3. Press the service utilities button (ambulance).
4. At the password prompt, enter the last 5 digits of the recorded

number reversed.
5. Press the "Squareness Corrections" button.
6. Press the "Save Volcomp to Software card" button. This procedure

is only available when two non-zero volcomps are shown in the
above screen.
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Introduction to DCC
Congratulations on the purchase of your RefleX DCC System.  We believe that
this is the easiest to use DCC package ever.

First and foremost, any operator using the dcc system for the first time have a
full understanding of the standard (non -DCC) system.  Perform chapters 1-4
tutorial exercises with the machine's drives disengaged, or with the jog box.
Only then will you have the knowledge necessary to proceed with this DCC
system.

The Jogbox
Not all of the features of the jog box are used in this system.  See the diagram
below:

Joystick - When not in playback, the joystick controls machine movement.
The machine will only move when the "Enable" button is pressed and the
green machine start light is on.

Velocity Indicator- This array of lights displays the
current fraction of full speed.

Enable - The button prevents accidental movement
of the machine.  In non-playback mode, the machine
will only move it this button is  pressed.

Print (Clearance Point) - This button is used to take
a clearance point.  This will be described later.  In this
system, it has nothing to do with printing.

Faster / Slower - These buttons increase or decrease
the current velocity.  The velocity will then be
displayed on the indicator above.

E-Stop - This is the button to press to stop the
machine.  After this button is pressed, controller will
apply the brakes to stop the machine as soon as
possible.  This is the button which should be used in
an emergency instead of the stop softkey.

Machine Start - This essentially turns the machine on and off.  The
machine will not move until it is started.   In order to start the machine, you
will need to press and hold this button for about 1 second.

DCC Stop Softkey

DCC Operation
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Starting the system:
Starting the system is extremely similar to starting a non-DCC system.  The
only exception is that you must ensure that the FBPC controller is turned
on first, or at the same time the RefleX controller is turned on.  The "Go"
softkey at the home screen signifies that RefleX is communicating with the
machine's controller properly.  Follow the procedures described in tutorial
2 to continue with system startup.

Before continuing, you should read sections 10-19 & 10-20 to get familiar
with the system's DCC options.

First Time Setup:
1.) Verify that the "uXcel pfx 454" machine type is selected in the

system option's page 1.  See section 10-4 for details.
2.) Enable the "Require points" option in the system

option's page 3.  See section 10-15 for details.
3.)     Enable the "DCC Playback" option in the system option's page 6.

See section 10 -19 for details.
4.) Set the remaining DCC options in page 6 appropriately.

Measuring Features:
Measuring features with the DCC system is very similar to the non DCC

system.  The two primary rules still exist:
1.)  Always approach perpendicularly.
2.)  Always allow at least 1 probe radius of approach.
Only by following these two rules can the system reliably solve the

feature type.

To measure a feature, you may use the system manually (I.E. unlock the
airlocks) or use the system's jog box.  If the your approach isn't perfect,
when the program is played back, it will be normalized automatically.  This
is especially usefully for parts learned manually, or parts not orthogonal to
the machine's axes when using the jog box.

Learned Normalized for playback

DCC Operation
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Clearance Points:
Clearance points, or move points, are use to move the machine without
actually taking a measurement point.  For example, the user would like to
move over to the top of a bore, drop down inside, measure a circle, and then
retreat out of the bore.  The sequence would look like this.

1.)  Move to the top of the bore.
2.)  Press the jog box's "Print" button.  A beep will be heard as the controller
      acknowledges the clearance point ( C1 below).
3.)  Move down into circle.  Begin taking points.  Note:  A clearance point
      here is not necessary because the system will automatically move to the
      start of the prehit zone to begin taking the first point.
4.)  Retreat out of the bore.  Take another clearance point (C2 below).
5.)  Press RefleX's "Done" softkey to solve the feature.

Tip:  Notice how we took a clearance point before and after the feature.  If
we would like to rearrange (edit)  the order of our program later, doing this
will make it much easier.

DCC Operation

Serial Output:
Because the system uses the serial port to communicate with the machine's
controller, serial output on the DCC systems is disabled.
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A typical application:
The following example shows a program for measuring multiple parts in a
fixture.  For this example, the system options "Alignments" has been set to
"Manual".

During playback, the operator measures these
features of the fixture manually.  (This will be
measured only once)

DCC alignment of part

DCC measurement of features begins

At the "end of program" screen, the user removes the part, places a new part
in the fixture, and presses the "Loop to below alignment" softkey to begin
measurement of the next part.Loop to below

alignment

Demonstration Mode:
The system can be placed in a demonstration mode for display purposes.
Because most customers will never use this, it remains hidden from view to
avoid confusion.  To start the demonstration mode, at the "End of Program"
screen, press the blank softkey 3 up from the bottom of the display.  A
"Demonstration Mode" screen will be displayed.  Press the "Go" softkey.  If
the "Alignments" option is set to "DCC", the system will loop back to the
block 1 of the program.  If the option is set to "Manual", it will loop back to
below the alignment.  The machine will continue to cycle until the "Stop"
softkey or E-Stop is pressed.

DCC Operation
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Measurement Results

Point Measurement

A point can be measured along a single axis only. The surface must be
approached along one of the machine's axes. The system compensates for the
probe diameter along the approach axis.

If you do not approach within 30° of the machine axis, the system can not
determine the approach direction. When this happens, a screen is displayed
for you to select the measurement axis.

Points can be measured with a hard probe, a TTP or a tapered probe. You can
also make a constructed point from the intersection of measured features.

Point Measured with a Hard Probe or TTP

Depending on the approach direction the screen
shows the X, Y or Z coordinate of the point. The
value is tip compensated. The status line at the
bottom of the screen also shows the axis used. The
Delta XYZ represents the perpendicular distance
from the point to the origin.

The second resultscreen also shows the rectangular and polar coordinates of
the point. The polar coordinates are given along the datum plane perpendicu-
lar to the measurement direction.

Measurement axis Polar coordinates
Z axis Top (XY) plane
X axis Side (YZ) plane
Y axis Front/Back (ZX) plane

U is the radial distance from the origin and V is the angle with the major
axis. The point is probe compensated along the measurement axis only.
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Measurement Results

Point Measured with a Tapered Probe
The screen shows the coordinates of the point along the major and minor
axes of the reference datum plane and the polar coordinates of the center.
The reference datum of the bore is determined by the approach direction.

Measurement axis Reference datum Major/Minor Coordin.
Z axis Top (XY) plane XY
X axis Side (YZ) plane YZ
Y axis Front/Back (ZX) plane ZX

U is the radial distance from the origin and V is the angle with the major
axis.

Constructed Point
The screen shows the rectangular and polar coordinates of the point. The
polar coordinates are reported on the Top plane (XY). U is the radial
distance from the origin and V is the angle with the X axis.
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Measurement Results

Line Measurement

Measured lines are always projected into one of the datum planes (Top, Side,
Front/Back planes). The system determines the plane based on the measured
line's approach direction.

If the system can not determine the approach direction, a screen is displayed
for you to select the datum plane. The system will compute the line on the
selected datum.

When measuring a line, start your approach at least one ball diameter away
from the surface. If you don't, the system will not know how to compensate
for the probe diameter. A screen is displayed that instructs you to move away
from the surface and press Done.

Lines can be measured with a hard probe or TTP. You can also construct a
line through the center of measured features and a symmetry line between
two other lines.

Measured Line (Always 2D) Results

If the line is square to a datum axis, the intersection
of the line and the axis is shown. If not, the perpen-
dicular distance to the origin is shown.The status line
at the bottom of the screen shows the reference plane.
The direction of the measured line is always from the
first to last measured point.

The screen displays a straightness plot of the
measured line. The top of the screen shows a
histogram of the deviations. The limits are the
minimum and maximum deviations. The plot
shows the deviation from the calculated line to
each of the measured points.

If the line is within the threshold value of being
square to the datum axis, the screen displays the
angle to that axis. If not, it displays the included
angle to the major axis.

0.010

-0.002
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Measurement Results

The screen shows the direction of out-of-square or
out-of-parallel and the deviation angle from a
perfect square (90°) or perfect parallel (0°). With
parallel lines the perpendicular distance between
the line and the datum axis is also shown.

When the line is oblique to an axis, the included
angle with the axis and the intersection point
is shown.

Squareness is computed as the tangent of the
square angle multiplied by the reference length.
It is only computed if the line is within the
specified squareness threshold.

Parallelism is computed as the tangent of the
parallel angle multiplied by the reference length.

Angularity is computed as the tangent of the
deviation from the reference angle multiplied by
the reference length. The system uses the
measured included angle as the default reference
angle. To set the reference angle, use the
Tolerance Selection button.

Constructed 2D Line
2D lines are created using the Construction Option in the Utility Menu. The
properties are the same as a measured 2D line except:

•  Form error is computed only if there are more than 2 points in the line
•  There is no straightness plot

Constructed 3D Line
A 3D line has no reference plane. They are created using the Construction
Option in the Utility Menu.

The screen displays the included angle with each datum axis on the
reference plane of the line. Angles are between 0° and 180°.

Ref. Length:
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Measurement Results

Circle Measurement

Measured circles are always projected into one of the datum planes (Top,
Side, Front/Back planes). The system automatically determines the projec-
tion plane.

If the system can not determine the datum plane, a screen is displayed for
you to select the datum plane. The system will compute the circle on the
selected datum.

When measuring a circle, start your approach at least one ball diameter away
from the surface. If you don't, the system will not know how to compensate
for the probe diameter. A screen is displayed that instructs you to select an
internal or external circle for measurement and press Done.

Circles can be measured with a hard probe or TTP. You can also construct a
circle through the center of measured features.

Measured Circle Results

The screen displays the major and minor
coordinates on the reference plane of the
center of the circle, the circle diameter
and the form error.

The screen displays a roundness plot
of the measured circle. The top of the
screen shows a histogram of the
deviations. The limits are the
minimum and maximum deviations.
The plot  shows the deviation from
the calculated circle to each of the
measured points.

0.010

0.080

-0.002

1 1/61

Roundness:

Roundness

Number Of Points:
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Measurement Results

The screen shows the true position location
of the circle on the reference datum plane.
You can switch between MMC Cartesian,
MMC Polar, RFS Cartesian and RFS Polar
and enter nominal values and tolerances
by using the softkey for the tolerance
window.

The bonus is displayed only for MMC.
The computed true position is shown as
the "cross" in the circle. An out-of-tolerance
"cross" is drawn outside the circle.

Polar coordinates are calculated on the
reference datum plane for the circle
diameter. U is the distance along the line
from the origin to the center of the circle
and V is the angle between this line and
the major axis.
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Measurement Results

Plane Measurement

When measuring a plane, start your approach at least one ball diameter away
from the surface. If you don't, the system will not know how to compensate
for the probe diameter. A screen is displayed that instructs you to move away
from the surface and press Done.

Measured Plane Results

If the plane is parallel to one of the
datum planes, the screen displays the
displacement of the centroid to the
parallel datum plane.

If the plane is oblique, the screen
displays the perpendicular distance
between the plane and the origin of
the datum system.

The screen displays a flatness plot
of the measured plane. The top of the
screen shows a histogram of the
deviations. The limits are the
minimum and maximum deviations.
The plot shows the deviation of each
point from the computed plane.

0

0.010

0.010

-0.002

1 1/61

Flatness:

Flatness

Number Of Points:
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Measurement Results

The screen shows the included angle
between the plane and each datum
plane (0°-90°).

If the plane is parallel to one of the datum
planes, the system computes the square-
ness to the other two datum planes.

The squareness is computed as the
tangent of the deviation angle from
parallel, multiplied by the reference
length.

The screen shows the parallelism to one
of the datum planes.

The parallelism is computed as the
tangent of the deviation angle from
parallel, multiplied by the reference
length.

For oblique planes angularity is
computed as the tangent of the deviation
from the reference angle, multiplied by
the reference length. The system uses
the measured included angle as the
default reference angle. Use the
Tolerance softkey to define the
nominal reference angle.



 A1-11

A
pp

en
di

x

RefleX Appendix

Measurement Results

Cylinder Measurement

Measured cylinders are always projected into one of the datum planes (Top,
Side, Front/Back planes). The system automatically determines the projec-
tion plane.

If the system can not determine the datum plane, a screen is displayed for
you to select the datum plane. The system will compute the cylinder on the
selected datum.

When measuring a cylinder, start your approach at least one ball diameter
away from the surface. If you don't, the system will not know how to
compensate for the probe diameter. A screen is displayed that instructs you
to select an internal or external cylinder for measurement and press Done.

Measured Cylinder Results

The system computes the pierce point
at the intersection of the cylinder's axis
and the reference datum plane, the
diameter and the form error. The
direction is always out of the datum
plane.

The screen shows the true position location
of the cylinder on the reference datum plane.
You can switch between MMC Cartesian,
MMC Polar, RFS Cartesian and RFS Polar
and enter nominal values and tolerances
by using the softkey for the tolerance
window.

The bonus is displayed only for MMC.
The computed true position is shown as
the "cross" in the circle. An out-of-tolerance
"cross" is drawn outside the circle.
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Measurement Results

If the cylinder is not square to a datum
plane, the system computes the elevation
angle (0°-90°) with the datum and the
rotation angles (0°-180°). Rotation
angles are the included angles with the
major and minor axes of the cylinder's
direction vector projected on the
reference plane.

Polar coordinates of the pierce point
of the reference datum plane and the
cylinder diameter. U is the distance along
the line from the origin to the pierce point
and V is the angle between this line and
the major axis.

The screen shows the squareness. The
squareness is computed as the tangent
of the deviation angle from square,
multiplied by the reference length.

The screen shows the parallelism. The
parallelism is computed as the tangent
of the deviation angle from parallel,
multiplied by the reference length.

For oblique cylinders angularity is
computed as the tangent of the deviation
from the reference angle, multiplied by
the reference length. The system uses
the measured elevation angle as the
default reference angle. Use the
Tolerance softkey to define the
nominal reference angle.
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Measurement Results

Cone Measurement

Measured cones are always projected into one of the datum planes (Top,
Side, Front/Back planes). The system automatically determines the projec-
tion plane.

If the system can not determine the datum plane, a screen is displayed for
you to select the datum plane. The system will compute the cone on the
selected datum.

When measuring a cone, start your approach at least one ball diameter away
from the surface. If you don't, the system will not know how to compensate
for the probe diameter. A screen is displayed that instructs you to select an
internal or external cone for measurement and press Done.

Measured Cone Results

The screen displays the coordinates of the
apex, angle, and the form error. The direction
of the cone is from the base to the apex. Note:
Use the System Option's "Cone Angle" option
and specify half angle or full angle.

The system computes the pierce point
at the intersection of the cone's axis
and the reference datum plane, and the
diameter at the pierce point level. If
the cone does not intersect the reference
plane, the diameter at the pierce point
is zero.

If the cone is not square to a datum
plane, the system computes the elevation
angle (0°-90°) with the datum and the
rotation angles (0°-180°). Rotation
angles are the included angles with the
major and minor axes of the cone's
direction vector projected on the
reference plane.
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Measurement Results

Polar coordinates of the pierce point
of the reference datum plane and the
cone diameter. U is the distance along
the line from the origin to the pierce point
and V is the angle between this line and
the major axis.

The screen shows the squareness. The
squareness is computed as the tangent
of the deviation angle from square,
multiplied by the reference length.

The screen shows the parallelism. The
parallelism is computed as the tangent
of the deviation angle from parallel,
multiplied by the reference length.

For oblique cones angularity is
computed as the tangent of the deviation
from the reference angle, multiplied by
the reference length. The system uses
the measured elevation angle as the
default reference angle. Use the
Tolerance softkey to define the
nominal reference angle.
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Measurement Results

Sphere Measurement

When measuring a sphere, start your approach at least one ball diameter
away from the surface. If you don't, the system will not know how to
compensate for the probe diameter. A screen is displayed that instructs you
to select an internal or external sphere for measurement and press Done.

Measured Sphere Results

The screen displays the XYZ coordinates
of the center, the diameter and the form
error.

Polar coordinates  and the sphere diameter.
The polar coordinates are reported on the
level plane (XY). U is the distance along
the line from the origin to the projection
of the sphere center onto the level plane
and V is the angle between this line and
the major axis.
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Point - Point

Both Points Measured with a Tapered Probe

Same Reference Plane
The screen displays the distance along
the major and minor axes and the 2D
distance between the points. The axes
are determined by the measurement
approach direction.
Measurement Axis Major and Minor Axes

Z Axis      X and Y
X Axis      Y and Z
Y Axis      X and Z

The screen displays a 2D line through
both points. The direction is from the
first to the second point. The angle of
the line with the major and minor axes
is displayed.

Different Reference Planes
The screen displays the 1D distance along
the each datum axis and the 3D distance
between the points.

Both Points Measured with a Ball or TTP

The screen displays the distance between
the two points along the measurement
axis.

The screen displays the XYZ location of
the midpoint between the two points,
along the 3D line connecting the points.

Measurement Results - Relationships
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Both Points Are Constructed

The screen displays the 1D distance along
the each datum axis and the 3D distance
between the points.

The screen displays the XYZ location of
the midpoint between the two points,
along the 3D line connecting the points.

Points Are Measured with a Tapered Probe and Constructed

The screen displays the 1D distance along
the each datum axis and the 2D and 3D
distance between the points.

The screen displays the XYZ location of
the midpoint between the two points,
along the 3D line connecting the points.

Points Are Measured with a Ball or TTP and Constructed

The screen displays the 1D distance along
the approach axis of the measured point.

Measurement Results - Relationships
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Measurement Results - Relationships

Point - Line

Constructed Point and Any Line

The screen displays the perpendicular
distance from the point to the line.

Point and Line Measured with a Ball or TTP

The screen displays the perpendicular
distance from the point to the line.

The point (without probe correction) is
projected into the reference plane of the
line. The distance is the perpendicular
distance from the projected point to the
line adjusted by the probe radius.

Point - Plane

Constructed Point and Any Plane

The screen displays the perpendicular
distance from the point to the plane.

Point and Plane Measured with a Ball or TTP

The screen displays the perpendicular
distance from the point to the plane.
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Point - Circle

Constructed Point and Any Circle

The screen displays the 1D distance
Between the center of the circle and
the point along each datum axis.

Point Measured with a Ball or TTP and Any Circle

The screen displays the 1D distance
between the point and the center of the
circle along the measurement axis of
the point.

Point - Cylinder

Point Measured with a Ball or TTP and Any Cylinder

The screen displays the 1D distance
between the point and the pierce point
of the cylinder along the measurement
axis of the point.

Constructed Point and Any Cylinder

The screen displays the perpendicular
distance from the point to the cylinder's
axis.

Measurement Results - Relationships
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Measurement Results - Relationships

Point - Cone

Point Measured with a Ball or TTP and Any Cone

The screen displays the 1D distance
between the point and the pierce point
of the cone along the measurement axis
of the point.

The screen displays the diameter of the cone
at a plane perpendicular to the cone's axis
passing through the point. If the plane is below
the apex of the cone, the diameter is 0.

Constructed Point and Any Cone

The screen displays the perpendicular
distance from the point to the cone's axis.

The screen displays the diameter of the cone
at a plane perpendicular to the cone's axis
passing through the point. If the plane is below
the apex of the cone, the diameter is 0.

Point - Sphere

Point Measured with a Ball or TTP and Any Sphere

The screen displays the 1D distance
between the point and the center of the
sphere along the measurement axis of
the point.

Constructed Point and Any Sphere

The screen displays the 1D and 3D
distances between the point and the
center of the sphere.
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Line - Line

Both Lines on the Same Reference Plane

Parallel Lines
The screen displays the parallel angle
and the perpendicular distance between
the two lines. The angle shows the
direction of out-of-parallel and the
deviation from a perfect parallel (0°).

The perpendicular distance is computed
from the centroid of the first line to the
second line.

The parallelism is computed as the
tangent of the parallel angle multiplied
by the reference length of the non-datum
feature.

Square Lines
The screen displays the square angle
and the intersection point of the two
lines. The angle shows the direction
of out-of-square and the deviation
from a perfect square (90°).

The squareness is computed as the
tangent of the square angle multiplied
by the reference length of the non-datum
feature.

Measurement Results - Relationships

Ref. Length:
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Measurement Results - Relationships

Non-Parallel and Non-Square Lines
The screen displays the intersection
point and the included angle between
the two lines. Each line is drawn in
the measured orientation.

The angularity is computed as the
tangent of the deviation from the
reference angle, multiplied by
the reference length. The system uses
the measured included angle as the
default reference angle. Use the
Tolerance softkey to define the
nominal reference angle.

Both Lines in Different Reference Planes

The screen displays the coordinates of the
half-way point along the perpendicular
between the two lines. It also displays the
shortest distance between the lines and
the included angle between the lines
(0-180°).
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Line - Plane

Line (2D or 3D) Parallel to Plane

The screen displays the parallel angle and the
perpendicular distance between the line and
the plane. The angle shows the direction of
out-of-parallel and the deviation from a
perfect parallel (0°).

The perpendicular distance is computed
from the centroid of the line to the plane.

The parallelism is computed as the tangent
of the parallel angle multiplied by the reference
length of the non-datum feature.

Line Square to Plane

The screen displays the square angle
and the intersection point between
the line and the plane. The angle shows the
direction of out-of-square and the
deviation from a perfect square (90°).

The squareness is computed as the tangent
of the square angle multiplied by the reference
length of the non-datum feature.

Line (3D) Oblique to Plane

The screen displays the coordinates of the
intersection point and the elevation angle
between the line and the plane (0-90°).

The angularity is computed as the tangent of the
deviation from the reference angle, multiplied by
the reference length. The system uses the
measured elevation angle as the default reference
angle. Use the Tolerance softkey to define the
nominal reference angle.

Measurement Results - Relationships
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Measurement Results - Relationships

Line - Circle

Non-Intersecting Line and Circle on Same Reference Plane

The screen displays the perpendicular
distance from the center of the circle
to the line.

Intersecting Line and Circle on Same Reference Plane

The screen displays the first intersection
point between the line and the circle.
This is the point where the line enters
the circle in the direction of the line.
The perpendicular distance is computed
from the center of the circle to the line.

The screen displays the second intersection
point between the line and the circle.
This is the point where the line exits
the circle in the direction of the line.
The perpendicular distance is computed
from the center of the circle to the line.
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Line - Cylinder

Line Parallel to Cylinder

The screen displays the parallel angle and the
perpendicular distance between the line and
the cylinder. The angle shows the direction of
out-of-parallel and the deviation from a
perfect parallel (0°).

The perpendicular distance is computed from
the pierce point of the cylinder to the line.

The parallelism is computed as the tangent
of the parallel angle multiplied by the reference
length of the non-datum feature.

Line Square to Cylinder

The screen displays the coordinates of the
half-way point along the perpendicular
between the cylinder and the line. It also
displays the shortest distance between the line
and the axis of the cylinder.

The screen displays the square angle
that shows the direction of out-of-square
and the deviation from a perfect square
(90°) between the line and the cylinder.

The squareness is computed as the tangent
of the square angle multiplied by the reference
length of the non-datum feature.

Measurement Results - Relationships
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Measurement Results - Relationships

Line Oblique to Cylinder

The screen displays the included angle
between the line and the cylinder.

The screen displays the coordinates of the
half-way point along the perpendicular
between the cylinder and the line. It also
displays the shortest distance between the line
and the axis of the cylinder.

The angularity is computed as the tangent of the
deviation from the reference angle, multiplied by
the reference length. The system uses the
measured included angle as the default reference
angle. Use the Tolerance softkey to define the
nominal reference angle.
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Line - Cone

Line Parallel to Cone

The screen displays the parallel angle and the
perpendicular distance between the line and
the cone. The angle shows the direction of
out-of-parallel and the deviation from a
perfect parallel (0°).

The perpendicular distance is computed from
the apex of the cone to the line.

The parallelism is computed as the tangent
of the parallel angle multiplied by the reference
length of the non-datum feature.

Line Square to Cone

The screen displays the coordinates of the
half-way point along the perpendicular
between the cone and the line. It also
displays the shortest distance between the line
and the axis of the cone.

The screen displays the square angle
that shows the direction of out-of-square
and the deviation from a perfect square
(90°) between the line and the cone.

The squareness is computed as the tangent
of the square angle multiplied by the reference
length of the non-datum feature.

Measurement Results - Relationships
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Measurement Results - Relationships

Line Oblique to Cone

The screen displays the included angle
(0-180°) between the line and the cone.

The screen displays the coordinates of the
half-way point along the perpendicular
between the cone and the line. It also
displays the shortest distance between the line
and the axis of the cone.

The angularity is computed as the tangent of the
deviation from the reference angle, multiplied by
the reference length. The system uses the
measured included angle as the default reference
angle. Use the Tolerance softkey to define the
nominal reference angle.

Line - Sphere

The screen displays the perpendicular
distance from the sphere center to the line
projected onto the reference datum plane.
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Circle - Circle

Different Reference Planes

The screen displays the distance between
the centers of each circle along the datum
axes.

Same Reference Planes

The screen displays the distance between
the circle centers along the major and minor
axes of the reference datum plane and the
2D distance between the centers.

The screen displays the angles of the line
passing through the center of the circles with
the major and minor datum axes. The
direction of the line is from the first to
the second circle.

The concentricity is computed as twice the
distance between the circle centers. It is
displayed only if it is less than the maximum
radius of the circles.

The screen displays the coordinates of the
circle intersection points along the major
and minor axes.

The screen displays the coordinates of the
midpoint of the slot, the width and the
length of the slot.

Measurement Results - Relationships
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Measurement Results - Relationships

Circle - Cylinder

Same Reference Planes

The screen displays the distance between
the circle center and the pierce point of the
cylinder along the major and minor axes of
the reference datum plane. It also displays
the 2D distance between the two points.

The concentricity is computed as twice the
distance between the pierce point of the
cylinder and the circle center. It is displayed
only if it is less than the maximum radius of
the circle and cylinder.

Different Reference Planes

The screen displays the distance between
the center of the circle and the pierce point
of the cylinder along the datum axes.
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Circle - Cone

Same Reference Planes

The screen displays the distance between
the circle center and the pierce point of the
cone along the major and minor axes of
the reference datum plane. It also displays
the 2D distance between the two points.

The concentricity is computed as twice the
distance between the pierce point of the
cone and the circle center. It is displayed
only if it is less than the maximum radius of
the circle.

Different Reference Planes

The screen displays the distance between
the center of the circle and the pierce point
of the cone along the datum axes.

Circle - Sphere

The screen displays the distance between
the sphere center and the circle center
projected onto the reference datum plane.
It also displays the 2D distances along the
major and minor axes.

Measurement Results - Relationships
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Measurement Results - Relationships

Plane - Plane

Parallel Planes

The perpendicular distance is computed from
the centroid of the second plane to the first.

The parallelism is computed as the tangent
of the deviation from parallel multiplied by the
reference length of the non-datum feature (the
second plane).

Square Planes

The squareness is computed as the tangent
of the deviation from square multiplied by the
reference length of the non-datum feature (the
second plane).

The screen displays the square angle
that shows the direction of out-of-square
and the deviation from a perfect square
(90°) between the two planes.

The screen displays the angles of the
intersection line between the two planes
with each datum axis.
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Plane - Plane

Non-Parallel and Non-Square Planes

The screen displays the included angle (0-90°)
between the two planes.

The angularity is computed as the tangent of the
deviation from the reference angle, multiplied by
the reference length of the non-datum feature.
The system uses the measured included angle as
the default reference angle. Use the Tolerance
softkey to define the nominal reference angle.

The screen displays the angles of the
intersection line between the two planes
with each datum axis.

Plane - Circle

Intersecting

The screen displays the coordinates of both
intesection points and the perpendicular
distance from the center of the circle to the
plane.

Non-Intersecting

The screen displays the perpendicular distance
from the center of the circle to the plane.

Measurement Results - Relationships
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Measurement Results - Relationships

Plane - Cylinder

Plane and Cylinder are Orthogonal

The screen displays the coordinates of the
intesection point of the cylinder's axis and
the plane along with the diameter of the
cylinder.

The screen displays the elevation angle (0-90°)
between the cylinder and the plane.

The squareness is computed as the tangent of the
deviation from the square multiplied by the
reference length of the non-datum feature.

Plane and Cylinder are Parallel

The screen displays the parallel angle and the
perpendicular distance between the plane and
the cylinder. The angle shows the direction of
out-of-parallel and the deviation from a
perfect parallel (0°).

The perpendicular distance is computed from
the pierce point of the cylinder to the plane.

The parallelism is computed as the tangent
of the parallel angle multiplied by the reference
length of the non-datum feature.
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Plane - Cylinder

Other

The screen displays the coordinates of the
intesection point of the cylinder's axis and
the plane along with the diameter of the
cylinder.

The screen displays the elevation angle (0-90°)
between the cylinder and the plane.

The angularity is computed as the tangent of the
deviation from the reference angle, multiplied by
the reference length of the non-datum feature.

Measurement Results - Relationships
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Measurement Results - Relationships

Plane - Cone

Plane and Cone are Orthogonal

The screen displays the coordinates of the
intesection point of the cone's axis and
the plane along with the diameter of the
cone at the intersection point. If the plane
does not intersect the cone, the diameter
is zero.

The screen displays the elevation angle (0-90°)
between the cone and the plane.

The squareness is computed as the tangent of the
deviation from the square multiplied by the
reference length of the non-datum feature.

Plane and Cone are Parallel

The screen displays the parallel angle and the
perpendicular distance between the plane and
the cone. The angle shows the direction of
out-of-parallel and the deviation from a
perfect parallel (0°).

The perpendicular distance is computed from
the apex of the cone to the plane.

The parallelism is computed as the tangent
of the parallel angle multiplied by the reference
length of the non-datum feature.
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Plane - Cone

Other

The screen displays the coordinates of the
intesection point of the cone's axis and
the plane along with the diameter of the
cone at the intersection point. If the plane
does not intersect the cone, the diameter
is zero.

The screen displays the elevation angle (0-90°)
between the cone and the plane.

The angularity is computed as the tangent of the
deviation from the reference angle, multiplied by
the reference length of the non-datum feature.

Plane - Sphere

Plane Intersects With Sphere

The screen displays the diameter and
coordinates of the center of the intesection
circle and the perpendicular distance from
the center of the sphere to the plane.

Plane Does Not Intersect Sphere

The screen displays  perpendicular distance
from the center of the sphere to the plane.

Measurement Results - Relationships
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Measurement Results - Relationships

Cylinder - Cylinder

Parallel Cylinders

The screen displays the parallel angle and the
perpendicular distance between the two
cylinders. The angle shows the direction of
out-of-parallel and the deviation from a
perfect parallel (0°).

The perpendicular distance is computed from
the pierce point of the second cylinder to the
axis of the first.

The parallelism is computed as the tangent
of the parallel angle multiplied by the reference
length of the non-datum feature (the second
cylinder).

Square Cylinders

The screen displays the coordinates of the
half-way point along the perpendicular
between the two cylinders. It also displays
the shortest distance between the cylinders.

The screen displays the square angle
that shows the direction of out-of-square
and the deviation from a perfect square
(90°).

The squareness is computed as the tangent
of the square angle multiplied by the reference
length of the non-datum feature.
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All Other Cases

The screen displays the coordinates of the
half-way point along the perpendicular
between the two cylinders. It also displays
the shortest distance between the cylinders
and the included angle.

The angularity is computed as the tangent of the
deviation from the reference angle, multiplied by
the reference length. The system uses the
measured included angle as the default reference
angle. Use the Tolerance softkey to define the
nominal reference angle.

Measurement Results - Relationships
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Measurement Results - Relationships

Cylinder - Cone

Cylinder Parallel to Cone

The screen displays the parallel angle and the
perpendicular distance between the cone and
the cylinder. The angle shows the direction of
out-of-parallel and the deviation from a
perfect parallel (0°).

If the cone was measured first, the perpendicular
distance is computed from apex of the cone to
the axis of the cylinder.

The parallelism is computed as the tangent
of the parallel angle multiplied by the reference
length of the non-datum feature.

If the cone and cylinder are concentric, the
system will display the "Intersecting Cone and
Cylinder" screen. The X, Y, and Z coordinates
are the coordinates of the intersect point.

Cylinder Square to Cone

The screen displays the coordinates of the
half-way point along the perpendicular
between the cylinder and the cone. It also
displays the shortest distance between the
cone and the cylinder axis.

The screen displays the square angle
that shows the direction of out-of-square
and the deviation from a perfect square
(90°).

The squareness is computed as the tangent
of the square angle multiplied by the reference
length of the non-datum feature.
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All Other Cases

The screen displays the coordinates of the
half-way point along the perpendicular
between the cylinder and the cone. It also
displays the shortest distance between the
cone and the cylinder axis.

The angularity is computed as the tangent of the
deviation from the reference angle, multiplied by
the reference length. The system uses the
measured included angle as the default reference
angle. Use the Tolerance softkey to define the
nominal reference angle.

Cylinder - Sphere

The screen displays the perpendicular
distance computed from the center of
the sphere to the axis of the cylinder.

Measurement Results - Relationships
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Measurement Results - Relationships

Cone - Cone

Parallel Cones

The screen displays the parallel angle and
the perpendicular distance between the two
cones. The angle shows the direction of
out-of-parallel and the deviation from a
perfect parallel (0°).

The perpendicular distance is computed from
apex of the second cone to the axis of the first.

The parallelism is computed as the tangent
of the parallel angle multiplied by the reference
length of the non-datum feature (the second
cone).

If the cones are concentric, the system will
display the "Intersecting Cones" screen.
The X, Y, Z and diameter coordinates
are the coordinates of the intersect point.

Square Cones

The screen displays the coordinates of the
half-way point along the perpendicular
between the two cones. It also displays the
shortest distance between the cones.

The screen displays the square angle
that shows the direction of out-of-square
and the deviation from a perfect square
(90°).

The squareness is computed as the tangent
of the square angle multiplied by the reference
length of the non-datum feature.
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All Other Cases

The screen displays the coordinates of the
half-way point along the perpendicular
between the two cones. It also displays the
shortest distance between the cones and
the included angle.

The angularity is computed as the tangent of the
deviation from the reference angle, multiplied by
the reference length. The system uses the
measured included angle as the default reference
angle. Use the Tolerance softkey to define the
nominal reference angle.

Cone - Sphere

The screen displays the perpendicular
distance computed from the center of
the sphere to the axis of the cone.

Sphere - Sphere

The screen displays the distances between
the sphere centers projected onto the XY
plane. It also displays the 2D distance.

The screen displays the distances along
each axis and the 3D distance between
the centers of the spheres.

Measurement Results - Relationships
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Measurement Results - Notes
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System Softkeys

The following list of softkeys will help you identify them as they appear in the software:

Insert Software
Card

Abort

Cycle Option

Done

Clear Last Hit

Tolerance

Enter Value

Next Result
Window

Print

Recall Datum

Scroll Up

Scroll Down

Next Screen,
Move right

Move Left

Probes

Relationship
Mode

Change Feature

Lower Menu

Upper Menu

Set Level

Set Axis

Set Origin

Delete Current
Block

Tools Menu

Store Feature

System
Options

Minus 1

Plus 1 Set Zero

Recall Probe Tip

Playback Stop

Enter Time

Enter Date

Serial Out

Scroll Up 10

Scroll Down 10

Enter Text

Zero XYZ

X Axis

Y Axis

Z Axis

Incremental
Zero

Absolute
Zero

+1 =.00

-1

0.0 05
+

Single Feature
Mode

Frown Face
Error

Service
Utilities

Zero X Axis

Zero Y Axis

Zero Z Axis

Scale Up

Scale Down

ISO Tolerance

Change Axis

Requalify

Qualify
Additonal Tip

Select

0: Z

0: Y

0: X

Z
Y

X?

Change Sign
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System Softkeys

The following list of softkeys will help you identify them as they appear in the software:

Save Probe Tip

Datum Menu

Save Datum

Translate Datum

Rotate Datum

Constructions

Construct a Line

Construct a
Circle

Construct a
Plane

Symmetry Line

Save  Program

Recall Program

Projection Point

Playback Utilities

Execute A Block

Exit Playback

Statistical
Histogram

Enable Statistics

Disable Statistics

Delete Record

Statistical
Summary

Statistical Run
Chart

Copy Mean

Part Drawing

Select Probe
Type

Save Startup
Probe

List Programs

Delete Program

Format Storage
Card

Digitize Mode

Force Cone

Inside Cone

Outside Cone

Inside Sphere

Outside Sphere

Force Cylinder

Outside
Cylinder

Inside Cylinder
/ Circle

Outside Circle

Force Plane

Force  Line

X Axis

Y Axisx

1

0

Reset Measure-
ment Mode

Print Front View
(ZX)

Height Gauge
Mode

Dial Indicator
Mode

Counter / Scribe
Mode

Construct From
Datum

Print Top View
(XY)

Print Side View
(YZ)

Measurements
Mode

D

1
2
3
4

Select Reference
Feature

Restart PlaybackSymmetryPlane

Symmetry Point Print Headers Digitize Outline Z Axis
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Demo Block Print
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Demo Block Print
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Storage Card
80-405-520-1

Air Saver
182-1206

Machine Stand / Cabinet
80-480-152

"Derby" Ball Bar Kit
182-1160

80-462-113-1
Refrigerated Air Dryer

B&S Demo Block
82-586

Picture Not available
Ball Bar Kit

682-104

Dot Matrix Printer
180-406-227-2

Clamp Kit
700-166

Machine Cover
82-1040

RefleX Demo Block
82-1631

RefleX Scan
(Digitizing Utility)

180-489-635-2

Demo Kit  (Distributors only)
181-242

Optional Hardware

10' Null Modem
 Serial Cable
80-406-782

Switch Box kit
180-415-344

Data Page RT
180-489-292

Vorne Display
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Optional Hardware

0-.57" Taper Probe
80-407-127

Ram Optical System
682-121

Adjustible Scribe
(Adj Probe Holder
Sold separately)

80-407-135
Replacement Tip

700-164Ball Probes
(1/4" shown)

1/8" Ball Probe 80-407-119
1/4" Ball Probe 80-407-120
3/8" Ball Probe 80-407-121
1/2" Ball Probe 80-407-122

MIP Probe Kit
180-407-268-5

Adj Probe Holder
80-407-137

Adjustable Ball Probes
( 1/8" shown)

(Adj Probe Holder sold separately)
1/8" Adj Ball Probe 80-407-123
1/4" Adj Ball Probe 80-407-124
3/8" Adj Ball Probe 80-407-125
3/4"Adj Ball Probe 80-407-136

Chuck Adapter Probe
80-407-132

Adj. Probe Adapter
80-407-131

Stylus Kit #103
80-407-274

Stylus Kit #201
(Case Not Shown)

700-190-118
   M3-M2 Adapter
   REPBSA3RU

Edge Probe
( Zero Diameter Probe)

80-407-134

.37-.80" Taper Probe
80-407-128

1.17-1.6" Taper Probe
80-407-130

.77-1.2" Taper Probe
80-407-129

Universal Probe Holder
(horizontal machines)

183-813
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RefleX Scan

RefleX Scan is an optional reverse-
engineering package for Windows 95/98
used in conjunction with the RefleX
system.  As you take points in the Digitize
mode, information sent out the serial port
via the null modem cable is captured by
this tool.  RefleX Scan takes the data and
converts it to workable DXF, IGES, VDA, or
GCODE CAD files.  These CAD files
contain non-probe compensated data (ball
center data) only.  The user must rely on the
capabilities of the CAD system to subtract
out the probe radius.

Installation:
1.  Place diskette 1 into floppy drive.
2.  From the "Start" menu, select "Run".
3.  Enter "a:\setup.exe".
4.  Follow instructions on screen.
5.  Further help is available in RefleX

Scan's on-line help.

Normal operating procedure:
1. Turn on RefleX.  Enter the Digitize

mode
2. Turn on the host computer. Run

RefleX Scan
3. Configure the RefleX Scan utility to

match RefleX's serial port settings.
4. Enter an appropriate intermediate file

name in the capture screen.  (ex.
"mypart.xyz"). Press the "Connect"
button.

5. Begin scanning the part while RefleX
Scan captures the data.

6. Press the "Disconnect" button to end
the scan. Press "Cancel" to quit the
"Data Capture" screen.

7. Press the "Convert" button.
8. Select the desired options for the

output file. Verify the output file name
is correct.

9. Press the "Start" button. After the
"Conversion Successful" dialog
appears, press "OK".

Package contents:
2 RefleX Scan installation disks.
1 RS232 Null Modem cable.
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RefleX Scan

The Configure Dialog:
Port Select - This is the port RefleX Scan
RS232 cable connects to on the host
computer (Usually COM1 or COM2).
Baud Rate - This is the speed RefleX Scan
receives the data. This setting must match the
setting in RefleX's "Printer & Serial Port
Setup" menu.  Available options: 1200, 2400,
 4800, 9600.  If you have problems, set this
option to 1200 in RefleX and RefleX Scan.
Parity - This setting helps prevent serial
communication errors. This setting must
match  the setting in RefleX's "Printer &
Serial Port Setup" menu. Available options:
None, Odd, Even. If you have problems, set
this option to either odd or even in RefleX and
RefleX Scan.
Data Bits - Also known as "Word Length",
this setting represents the amount of data to
be sent at one time. This setting must match
the setting in screen 4 of RefleX's system
options.
Stop Bits - This setting represents the number
of bits used to represent the end of a word
transmission. This setting must match the
setting in RefleX's "Printer & Serial Port
 Setup" menu.
OK - Keeps these settings for this session
only, unless the Save button has been pressed
 previously.
Cancel - Disregard all setting changes.
Help - Invoke on-line help, similar to this
page.
Save - Saves all settings.

The Capture Dialog:
Connect - After entering a valid path
and file name with the "xyz" extension,
press this button to proceed to the next
screen.
Cancel - Disregard all entered informa-
tion.
Help - Invoke on-line help, similar to
this page.
Browse - Browse for a location to save
the file.
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RefleX Scan

The Capture Dialog #2:
After pressing the "Connect button"
this dialog appears.  As points are
taken, the "Line Count" will incre-
ment:  (0, 1, 2, 3... etc.)
Disconnect - When finished collecting
data, press the disconnect button.

The Convert Dialog:
Conversion Type - Choose the output file type:  DXF, IGS, VDA, GCODE.
Output Type - If "Points" is selected, the cad file will consist of points. If "Lines"
is selected, the cad system will connect all of these points.
Units - Select Inches or millimeters:  Inch, MM.
Lock Axis to first value - The first X, Y, or Z position, used in all subsequent
points.
Axis Lock Value - The X, Y, or Z position entered, used in all subsequent points.
Input File Name - The name of the file entered in the capture screen. (ex.
mypart.xyz)
Output File Name - The desired name for the output CAD file. (ex. mypart.dxf)
Start - Begins the conversion process.
Cancel - Disregard all setting changes.
Help - Invoke on-line help
Save - Save all settings.
Browse - Browse for a file location.
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RefleX Scan - Frequently Asked Questions

Q: Will RefleX Scan work in Windows NT or 2000?
A: Some customers have reported that RefleX Scan 1.5 works in Win NT.

However, because it has not been extensivly tested, it is not yet sup-
ported.

Q: What type of serial cable does RefleX Scan use?
A: RefleX Scan uses a standard null modem serial cable.

Q: How can I use DXF files in AutoCad 12/13?
A: Because of the changed requirements for AutoCad 12/13 DXF files,

RefleX Scan version 1.0 will not work in AutoCad 12/13. To correct the
problem, install RefleX Scan 1.2 or the later version 1.5

Q: How can I update to the latest version 1.5?
A: Contact reflexsupport@us.bnsmc.com

Q: Where can I get answers to my RefleX Scan questions and report any
RefleX Scan problems?

A: You can talk with your local distributor and, in addition, you can use
the RefleX support email address:  reflexsupport@us.bnsmc.com

Q: Is RefleX Scan Year 2000 Compliant (Y2K)?
A: Because RefeX Scan does not use any time/date functions, RefleX Scan

is inherently Year 2000 Compliant.

Q: When I look at a RefleX Scan CAD file, the points appear to be offset.
A: The points are offset because the RefleX and RefleX Scan systems do

not probe compensate the data. For this operation, you must rely on the
CAD system.

Q: My RefleX Scan won't install/run?
A: Verify that oleaut32.dll, olepro32.dll, msvcrt40.dll, & msvcrt.dll are in

the Windows "System" directory. These files can be obtained from the
Windows 95 and Windows 98 installation CDs.

Q: RefleX Scan seems to be installed correctly, but it is not collecting data.
A: Most problems with RefleX Scan involve the serial link between the

host computer and the RefleX Controller. Establish that link, using the
"Connect RefleX to a host PC" procedure.  (next page)



 A6-1

A
pp

en
di

x

RefleX Appendix

Connecting RefleX to a Host Computer

The following is the setup and procedure for sending data from the RefleX
system to a host computer running Windows NT or Windows 95 via the
Hyperterminal program.  Although there are slight differences between the Win
NT version of Hyperterminal and the Win 95 version, the connection process is
almost the same.

Finding Hyperterminal on the host computer:
1. Click on the Start Menu
2. Click on the Accessories folder
3. Click on the Hyperterminal folder
4. Click on the Hyperterminal program

Hyperterminal Configuration:
1. When prompted for a "Connection Description", press the cancel button.
2. From the File menu, select properties.
3. In the "Connect to" tab, select "Direct to COM1" in the "Connect using"

option box.
4. Press the Configure button and set the following items and then press OK.

Bits per Second:  9600
Data bits: 8
Parity: None
Stop Bits: 1
Flow Control: Xon/Xoff

5. In the "Settings" tab, change the Emulation type to VT100. Press OK
6. Hyperterminal is now properly configured. If you plan to perform this

connection again, save this session using the "save as" in the file menu.

Capturing Data with Hyperterminal
1. From the "Transfer" menu, select the "Capture Text..." menu item.  When

prompted, enter  an appropriate file name. (Default is: C:\Program
Files\Accessories\Hyperterminal\ Capture.txt). Press the start button.
Note:  This name must be changed next time or your data will be
overwritten!

2. From the "Call" menu, select the "Connect" menu item. In NT, the
Connected "0:00:00" will now be incrementing. In Win 95 a name such as
"RefleX" must be given to the "Connection Description" window,
followed by OK, OK. This confirms the previously entered settings.



 A6-2 RefleX Appendix

Connecting RefleX to a Host Computer

Sending Data from RefleX
1. From the second page of the Tools menu in the Measurement mode,

Enter the "Output Selection" menu. Enable serial communications by
selecting either Datapage, Gage Talker, Mitutoyo, Generic, or Print
format.

2. As the part program is being created, press the mark screen button
(looks like a lightning bolt) to designate which screens are to be
outputted. If you do not wish to have certain values printed, tolerance
them to "None".

3. Serial data will be exported when the program is executed in the playback
mode.

4. Data can also be sent from the digitize mode.

Closing Hyperterminal
1. From the "Transfer" menu, select the "Capture Text..... Stop" menu

items.
2. From the "Call" menu, select "Disconnect".
3. From the "File" menu, select "Exit" to close Hyperterminal.
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Installing a Replacement Controller

General Procedure:
1. Load the Volcomp file.
2. AutoTune
3. Select Machine Type

1.  Loading the Volcomp File
a. Install the controller as shown in the installation manual (cables,

mountings, etc.)
b.   Remove old software (top) and storage (bottom) smart cards from the

old controller.
c. Insert the old cards into the new controller.
d. Turn on the new controller. Wait for language screen to appear. Select

language. Press Done.
      e. The volcomp load screen, shown below will appear. Press the Done

softkey and your volcomp file will automatically be loaded from the
software card.

IMPORTANT: Never swap software cards between multiple systems.
Because the volcomp file is stored on the software card, as well as the
controller, moving the software card to a new controller can cause
problems which can only be resolved by a service call.

Note: The volcomp number, displayed at the upper left section of the
homing screen, will now match the machine serial number found on the
back of the machine.
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Installing a Replacement Controller

2.  AutoTuning
Please read the instructions in their entirety before attempting the AutoTune
process. You will be entering the service utilities section of the software and
can cause irreversible damage if not used correctly.  Stay out of all areas
unless specifically instructed by this document or by a service person.  If you
have questions, please contact your local service person before proceeding.

a.  What is AutoTune?
AutoTune is the electronic process for adjusting the RefleX encoder signals.
Before AutoTune, the tuning process had to be done by a qualified Brown &
Sharpe service technician, resulting in downtime.  Now, this process can be
done faster and more accurately by you.

b.  When should I do an AutoTune?
• After installing a replacement controller
• If "Rate Errors" appear.
• If instructed by a service person.

c.  What should I do before an AutoTune?
• Verify that all encoder cables are plugged in securely in their proper

port.
• Verify that scales are clean
• Check encoder's raw signal levels, described in section g.

d.  What causes "Rate" errors?
A rate error is the electronics way of notifying you that the encoder signal
quality is unacceptable.  Because of that, exact machine position may be in
error.  There are many variables that can cause rate errors.  There include:

• The controller is a new controller not yet Autotuned.
• An encoder cable is not plugged in securely
• The previous AutoTune was performed incorrectly.
• An encoder's performance has degraded or an encoder has slipped

out of alignment.
• There is dust, dirt, oil, or a scratch on a scale.
• The encoder cable has a broken wire.
• A hardware error has occured inside the controller.

e.  Where do I find the Service Utilities?
• At the home screen, record the number at the top left of the screen.
• Select the "Service Utilities" (ambulance) softkey.
• At the password promt, enter the last 5 digits of the recorded serial

number, reversed.
• Press the "Done" softkey.  You are now in the Service Utilites.
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Installing a Replacement Controller

f. The AutoTune Process:
• Check the raw encoder signal levels.  (Section g)
• AutoTune.  (Section h)
• Recheck encoder signal levels.  (Section i)
• Verify AutoTune in the Measurement Mode.  (Section j)

g. Checking Raw Encoder Signal Levels:
• Enter the service Utilities. (Section e)
• Press the "Align Encoders" softkey.
• Confirm "Before AutoTune" is displayed at the top of the screen.
• Begin moving the axes back and fourth. Verify that all signal levels are

above the dotted line while axes are in motion. If not, a service visit
may be required.

• Press the "Done" softkey. This will return you to the Service Utilties
menu.

h. The AutoTune Process:
• In the service menu, press the "AutoTune" softkey.
• As prompted, bring the Z-rail to the home (upper, left, front) position.

Press the Done softkey.
• Immediatly after the Done button is pressed, begin moving the machine

towards the lower, right, back position. Move so that it takes you
approximately 25 seconds to reach this position (lower, right, back).
DO NOT stop the machine during the AutoTune! All axes must be in
continuous motion. AutoTune should finish before it reaches its
desination, near the center of the volume.

• When the "AutoTune Passed" screen appears, press the "Done"
softkey to save the results.

• If the "AutoTune Failed" screen appears, repeat the AutoTune process
(Press cancel and repeat above steps). If still unsuccessful, contact
your local service person.

i.  Checking "After AutoTune" Signal Levels:
• In the Service Utilities menu, return to the "Align Encoders" section by

pressing the "Align Encoders" softkey.
• Press the "Change Option" (circular arrow) softkey to look at the

AutoTuned signal levels.
• Confirm "After AutoTune" is displayed at the top of the screen.
• Begin moving the axes back and fourth again. While the axes are in

motion, verify that all signal levels remain between the dotted lines.  If
not, then repeat the AutoTune process.

• Press the "Done" softkey. This will return you to the Service Utilites
menu.
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Installing a Replacement Controller

j.  Verifying Lissajous patterns
• In the Service Utilities menu, press the "Lissajous" softkey.
• Lock the Y & Z axes.  Unlock the X axis.
• Begin moving the X axis slowly.  Verify that a nice, round circle

appears.  The circle should move through, or close to the 4 tic
marks.  If it does not, you may need to try autotuning again.

• Repeat the process for the Y & Z axes.

Note:  The lissajous utility was developed so that signal levels can be
viewed without the use of an oscilloscope.  But, because the controller
is not as fast as an oscilloscope, moving an axis too fast will cause the
pattern to become elliptical, slanted at a 45% angle.  If this happens,
simply slow down.

k. Verify Tune in Measurement Mode.
• Press the "System Startup" button (below the help button). This will

return you to the "homing" screen. After homing the machine, press
the "Done" softkey.

• If the software asks you to qualify a probe, follow the instructions
on the screen to qualify a probe as usual.

• Enter the measurement mode.
• Move the Z-rail in all 3 axes throughout the volume of the machine

for a time period of 1 minute.  If no rate errors appear, then
AutoTune was successfull.

3. Setting the Machine Type:
The final step of installing a replacement controller is to inform the
Controller about the machine. The system scales its part drawings depend-
ing on whether a Gage2000, MicroXcel, or other machine is used.

a. Enter Screen 1 of the System Options
b. Scroll down to "Machine Type".
c. Select your machine.
d. Press the "Done" softkey. Your specific machine will now appear in

the home screen the next time your system is homed.

Note:  In the event that a controller has to be returned, be sure to
include the power supply also.  Only in that way can it be fully
diagnosed and repaired.
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Installing a Software Card

If you receive a new software card, do the following:
1. Remove the previous version software card from the top slot. (The

controller can stay powered up.)
2 Insert the new software card in the top slot.
3. After a possible language screen, the "Volcomps Do Not Match"

screen will appear as shown below. Simply press the Done softkey.

4. Do Not re-insert your previous version software card unless
absolutely necessary. This may cause the loss of your system
variables (Inches/mm, language, air-saver time, etc.).

5. If you received a defective or unprogrammed card resulting in a
"frown face" icon being displayed with no error code written below
it, contact your local service person for a replacement card. If there
is an error code shown, the controller is experiencing other problems
which may require the attention of a service person.

6. Return the old software card in the envelope provided.
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Accuracy Troubleshooting
Question / Suggestion
Does Serial number of the machine
match the number at the upper left
corner of the home screen?

Is the qual sphere diameter, found in
page 2 of the system options, correct?

Are proper measuring techniques
being used to measure the part?

Is the part secure?

Is the room at 20 degrees Celsius,
away from direct sunlight, vents,
vibrations, etc.?

Clean tip, qualification sphere and
part with alcohol.

Is the qualification result good?  +/- 5
microns for diameter, +/- 10 microns
form error?

Use a ring gage to find out if the
problem is in 1 axis, or in all 3.

Verify signal quality using the service
utilities "Lissajous Plot".

Verify the measurement in question is
valid for a accuracy / repeatability test.

What size tip is being used?

What type of TTP is being used?

Detail
If RefleX's home screen is not showing the correct serial
number, than this means that the controller does not have the
correct volcomp installed.   A new software card with the
correct volcomp will have to be obtained.   See section 11-6,
11-7.

Enter the value stamped on the qual sphere's shaft into the
system.  See section 10-9.

Always approach perpendicularly, allowing at least 1 probe
radius of approach vector.  If the operator fails to do this,
values may be off by either 1 probe radius or diameter, if the
system can even solve it.

Make sure the part is properly clamped to the granite.

The machine must be in an environmentally controlled area to
obtain good measurement results.

Dust, dirt, oil, etc. are common causes of measurement error.
Clean these items regularly.

If not, first, use a stylus key verify stylus is tight.  If that
doesn't help, try a different stylus.  Remove any extensions.  If
that doesn't help, and another probe is available, try replacing
to eliminate the probe from the equation.  If using a MIP,
verify attenuation is set properly.

Measuring a ring gage in the 3 different orientations will help
diagnosing where the problem lies.

Poor signals increase sub division error.  Re-AutoTune if
necessary.  See section A7-4.

For example, a user is getting unacceptable repeatability
when measuring only a 10 degree slice of a circle. See section
3-13 for more information.

For less than perfect surface finishes, consider increasing the
tip size.  See section 3-13, step 4 (towards the bottom)

If you are using a TP-ES, consider upgrading to a TP-MIP.
See section 3-13, step 6 (towards the bottom).
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Index

Abort Softkey
Absolute softkey (Scribe Mode)
Acceleration - Max (DCC)

See "Max Acceleration"
Accuracy Troubleshooting
Add Record (Statistics)
Air Locks
Air Saver
Aligning a part
Alignments

Line Line Intersect Alignment
Circle Origin Alignment

Alignments Tutorial
Alignments (DCC Option)
Angles
Arcs
Arm Speaker Volume
AutoTune
Axes (See "Machine Axes")
Ball Probe
Baud Rate
Bolt hole pattern

See "Constructed Circle"
Booting controller

See "Controller Won't Boot"
Cable

See "Null Modem Cable"
Can Not Solve Error
Cards

See "Smart Cards"
Change Feature Type
Change Option softkey

See "Cycle Option Softkey"
Circle

See "Measuring A ...."
Clearance Points
Clearance Speed
CMM (See "Coordinate Measuring Machine")
Computer

See "Connecting to a Host... "
Cone

See "Measuring A...."
Cone Angle
Connecting to a Host Computer
Construct from Datum

5-14
7-4

A9-1
5-25

2-7
2-4,10-6,A4-1

4-4
1-7,4-3,4-4,4-5

4-3
4-4
4-1

10-20
10-6
3-13
10-5
A7-2

5-4
10-16

2-12

5-9,3-13

12-5, 12-3
10-20

10-10
A6-1
5-23

Constructed Features
Constructed Circle
Constructed Line
Constructed Plane
Constructed Point

See "Symmetry Point"
Construction

See "Constructed Features"
Contrast
Controller

See "Installing a ..."
Controller Lockups
Controller Won't boot
Coordinate Measuring Machine
Coordinate Systems

part coordinate system
machine coordinate system

Copy Mean (Statistics)
Copyright Screen
Counter Mode
Create Work Instruction
    See "Work Instruction"
Cycle Option softkey
Cylinder

See "Measuring A...."
Cylinder Threshold

See "Minimum Cylinder Depth"
DataPage
DataPage (serial output)
Datum
Datum A (See "Set Level")
Datum B (See "Set Axes")
Datum C (See "Set Origin")
Datum Status
Decimal Places

See "Trailing Places"
Delete Block
Delete Program
Delete Record (Statistics)
Delimiter
Demo Block
Demonstration Mode
Dial Indicator Mode
Digitize Mode

See also "RefleX Scan"

5-21,1-11,1-12
1-11,5-22

5-21
5-22

10-7

11-4
11-4

1-3,1-4
1-5,1-6,1-7

1-6,1-7
1-5,1-7

5-25
2-4

7-1,10-18

2-8

5-25, A4-1
10-12

5-20,1-7,1-8

5-6

5-13,5-33
5-31
5-25
10-6

3-5,3-4,A3-1,A4-1
12-6

6-1,10-17
9-1,10-18
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Index

Tolerance Softkeys
Help Button
Histogram (Statistics)
Homing the Machine (Home Screen)
HyperTerminal
Icons

See "Softkeys"
Inches

See "Units"
Incremental Softkey (Scribe Mode)
Inserting a probe
Installing a Replacement Controller
Introduction to Coordinate Metrology
ISO tolerancing
Jogbox
Jump to below alignment

See "Loop to below alignment"
Keyboard
Keyin Values softkey
Languages, Language Screen
Leap Frog
Line

See "Measuring A..."
Lissajous Plot
List Programs
Loading software
Locating the Qualification Sphere
Lockups

See "Controller Lockups"
Loop to below alignment
Lower Menu Softkey
Machine axes
Machine coordinate system
Machine Serial Number
Machine Type
Max Acceleration (DCC)
Measured Features
Measurement Mode
Measurement Results
Measuring Features Tutorial
Measuring

A Circle
A Cone
A Cylinder
A Line

8-9
8-10
5-25
2-7

A6-1

7-4
2-10

A7-1
1-1

5-14
12-3

10-13
5-19

2-5,10-5
5-35

A7-4
5-32
2-4
2-9

12-6,5-29
5-8,3-8,3-9

1-5
1-5,1-7

2-7,A7-1
2-7,10-4

10-20
1-11

3-3,5-1,10-18
A1-1

3-1

3-12,3-13
3-19

3-17,3-13
3-10

Digitize Outline
Digitize Serial Output
Disk Probe Qualification
Done softkey
Drawing

See "Part Drawing"
Editing Sequences (Programs)
Effective Probe Techniques
Email Address
Enabling Statistics
Encoders
Execute Block

See "Playback"
FAQs
    See "Frequently Asked Questions"
Feature Construction

See "Constructed Features"
Feature Labeling
Feature List
Fixtures
Flatness
Formatting (Storage Card)
Frequently Asked Questions
Flying Probe
Force Feature Type

See "Change Feature Type"
Frown face Icon
Gage Talker (serial output)
Generic Format (serial output)
GD&T Symbols
Hard Probe Scanning Screen

See "Scanning Screen"
Hardware

See "Optional Hardware"
Headers

See "Print Headers"
Heidenhain Controllers
Height Gauge Mode

Measuring a bore
Measuring a point
Measuring a slot
Measuring in the....
Overview
Result Screens
Softkeys

5-26
9-4

2-12
2-5

5-33
1-18,1-19,1-20

2-4
5-25

A7-2,A7-3,A7-4

5-35
5-5,5-7

12-6,10-20,5-29
6-4

5-32
11-3
10-4

2-4, 11-4
10-12
10-12

5-16

10-4

8-1,10-18
8-5
8-4
8-5
8-4
8-3

8-6,8-7,8-8
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Index

A Plane
A Point
A Sphere

Measuring a sphere
Measuring Modes

See "Startup Options"
Minimum Cylinder Depth
Minimum Distance Option
Mitatoyo Serial Output
Move Points

See "Clearance Points"
Moving a horizontal machine
Moving Measured Blocks
Mux10

See "Mitatoyo Serial Output"
MM

See "Units"
Mouse
Nearest Nominal
Next Item Softkey
Next Result softkey
Next Tip softkey
Null Modem Cable
Offset Plane

See "Constructed Features Plane"
Optical Probe
Optional Hardware
Origin

See also "Set Origin"
Other Machine Type
Output Status
Parity (Serial)
Part alignment

See "Aligning a part"
Part coordinate system

Part Drawing
Part Fixturing

See "Fixtures"
Passthrough Mode
PC-DMIS
Perpendicular Angles Option
Plane

See "Measuring A..."
Playback

Creating an Inspection

3-15
3-4

3-21,2-11
2-11

10-9,3-13
5-35

10-12

5-33
5-33

10-16
5-15,3-18,10-9

5-14
5-14
5-19

9-3, A4-1,A5-1

A4-2
A4-1

10-4
5-7

10-16

9-5,0-6
9-5,9-6

10-11

5-27,28,29,30,31,32
5-28

Error Recovery
Execute Block
Executing a program
Exiting Playback
Overview
Planning an Inspection

Playback Pause
Point

See  "Measuring A..."
Points/Sec option
Porting Features
Posthit distance
Posthit speed

See "Pre/posthit speed"
Power Supply
Power Switch
Precision

See "Trailing Places"
Prehit distance
Pre/posthit speed
Print Company
Print Date
Print Format

See "Printer Format"
Print Headers
Print Note
Print Operator
Print PartName
Print Time
Print Top/Side/Front View
Printer

See also "Send to Printer"
Printer Format
Printer Picture & Part Number
Printers supported
Printing Results
Probe Compensation

See "Tip Compensation"
Probe Holder
Probe Offsets
Probe Qualification
Probe Status
Probe Removal

See "Remove Probe"
Probe Qualification Results

5-29
5-29
5-28
5-29
5-27
5-28

10-13

10-8
5-35

10-19

A7-4, 11-4
2-3

10-19
10-20
10-13
10-14

5-33,10-13,10-14,10-15
10-15
10-13
10-14
10-14

3-9

10-15
A4-1

10-11
5-26,10-11,10-16

10-17
5-18

2-8
5-6

2-12
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Index

A4-2
5-19
5-23

1-15,1-16
2-8,2-11, A9-1

2-12,10-10

5-19
11-5

5-20,4-5,1-10
5-20,6-3

5-31
5-19
5-31

5-34
10-9
5-7

A5-1,A4-1
5-8

5-24
5-33
5-19
2-9
5-3

4-3
3-8,5-5,A1

5-25
6-3

4-4,5-20

5-4
5-7

7-4,10-17
6-3

2-5,5-8

Select Probe Type
Select Axis
Self Diagnostics
Send out Serial
Send to Printer
Serial

See "Serial Output"
also "Connecting to a computer"

Serial Cable
See "Null Modem Cable"

Serial Number
See "Machine Serial Number"

Serial Output
Digitize Mode
Measurement Results
Toleranced (Print Format)

Service Utilities
Set Axes
Set Level
Set Origin
Shanking
Single Feature Display softkey
Skull & Crossbones icon

See "Frown Face Icon"
Smart Cards

Hot Swapping
Softkeys
Software Card
Software Version
Speaker

See "Volume (Speaker)
Sphere

See "Measuring A..."
Squareness Limit
Standard Probe Holder

See "Probe Holder"
Startup Probe
Startup Tutorial
Statistics
Status Bar
Stop Bits (Serial)
Storage Cards
Store Feature Softkey

See "Store Relationship"
Store Program

5-18
6-3,8-4

2-4
10-12

5-10,4-3

9-4
10-12,5-7

5-15
2-7,5-35
5-11,4-3
5-10,4-3
5-12,4-3

1-19
5-8

2-3,2-4,5-30,5-32A8-1
2-6,2-4
3-7,A2

2-3,2-4,2-6,A8-1
2-3

10-5

10-10

2-8,2-12,5-19,10-6
2-1

5-25
5-6,5-7,5-3,5-4

10-16
2-3,2-4,2-6,10-3,A4-1,A7-1

5-30

Probe Techniques
See "Effective Probe Techniques"

Probes
Probes Softkey
Projection Point
Projections
Qualification Sphere
Qual Sphere Diameter
Qualification Results

See "Probe Qualification Results
Qualify additional tip softkey
Rate Error
Rotation
Recall Datum
Recall Program
Recall Tip softkey
Reclamation (Card)
RefleX Demo Block

See "Demo Block"
Reference Feature
Reference Length
Reference Plane
RefleX Scan
Relationship Mode Softkey
Relationships (Any 2 features)
Replacing Measured Blocks
Remeasure Tip softkey
Removing a probe
Reorienting a probe
Replacement Controller

See "Installing a .... "
Reset Measurement Mode
Result Screens/Windows
Run Chart (Statistics)
Runout
Saving Datums
Save Startup Probe

See "Startup Probe"
Saving a program

See "Store Program"
Scanning Screen
Screen Counter
Scribe Mode
Scale Up/Down
Scroll Up/Down softkey
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Store Relationship
Straightness
Summary Data (Statistics)
Support Web Site

See "Web Site Address"
Switch Box Kit
Symbols

See "GD&T Symbols"
Symmetry Line
Symmetry Plane
Symmetry Point
System Modes
System Options
System Startup
System Startup Button
Tip Compensation
Tips - Number allowed
Tolerance softkey
Tolerancing ISO

See "ISO Tolerancing"
Tolerancing Results
Tools Menu softkey
Tools Menu

See specific tool
Touch Trigger Probe
Troubleshooting
TTP

See "Touch Trigger Probe"
TTL Controller
TTP Preview Screen
Trailing Places
Translation
Units (Inches/mm)
Universal Probe Holder

See "Probe Holder"
Upper Menu
Velocity Speedometer

See "Speedometer"
Volcomp
Volcomp Mismatch
Volume (Speaker)
Volumetric Compensation

See "Volcomp"
Vorne Display
Web Site Address

5-13
6-4

5-25

A4-1

5-23
5-23
5-22

2-14,  2-13
2-7,10-1..18

2-1
2-13,6-4

1-17
2-12, 5-6

5-8

5-14,5-15
5-8

1-18,1-19,1-20,2-9,5-3
11-3

10-4
5-3

5-20,4-5,1-9
10-5

5-8,3-8,3-9

1-13,1-14,2-6,9-5
11-6..8,A7-1,A8-1

10-5

10-17, A4-1
2-4

Word Length (Serial)
Work Instructions
XON/XOFF (Serial)
XYZ Air Locks
XYZ Machine Axes

See "Machine Axes
XYZ Counter Mode

See "Counter Mode"
XYZ Plot

See "Lissajous Plot"
Y2K Compliance
ZMouse

See "Mouse"

10-16
5-35

10-17
2-7

10-14
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